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HIGH VOLTAGES ARE PRESENT BEHIND THE COVERS AND IN THE CONTROL BOX

here are no user serviceable parts inside. The electrical and/or sensitive parts may only be serviced by an
rvice Representative.

] ges or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s
Gperate the equipment.

plosxon 1f battery I8 mcorrectly replaced. Replace only with the same or equlvalent type recommended by the
Dlspose of used battenes accordmg to the manufacturer’s 1mtrucuons

Explosnonsgefahr bei unsachgemaﬁem Austausch der Batterie.
Ersatz nur durch denselben oder einen vom
Hersteller empfohlenen gleichwertigen Typ.

Entsorgung gebrauchter Batterien nach

Anoaben des Herstellers.

~ ADVARSEL .
L1th1umbatten - El\splosmnsfare ved feﬂagn g héndtering.

Udskiftning mé kun ske med batteri af samme fabrikat og type.
Levér det brugte batteri tilbage tilleverandgren.

tion in this document is subject to change without notice. No warranty of any kind is made with regard to
contained herein. The manufacturer will not be liable for incidental or consequential damages in
with the furnishing, performance or use of this material.




Introduction |

This manual is for the person who is new to the Bryce OEM
Address Printer and needs step by step instructions to setup and
operate the printer.

The appendix at the end of the manual has information for those
who are familiar with the OEM printer and simply want a quick
reference or want more specific technical information on the OEM
printer.

Section 1 - Unpacking
A list of the components that came with your new printer.

Section 2 — Setting up the Printer
Describes the basics of how to setup and install the components of
the printer for the first time.

Section 3 — Trying out the Printer
Step by step instructions to operate the address printer and some
adjustments to maximize the performance of the printer.

Section 4 —Printer Tips
Additional adjustments and instructions to fine tune the printer.

Section 5 — Adjusting the Sensor
Step by step instructions to adjust the sensor and some
considerations when setting up the sensor.

Section 6 — Printer Menu System
Explains each of the menu options of the address printer.

Section 7- Troubleshooting and Diagnostics
A list of possible problems you may encounter when operating the
printer and their solutions.

Section 8 — Cleaning and Maintaining the Printer
General maintenance steps to keep the printer clean and functioning

properly.

Appendices

The appendices include a quick reference table for the OEM menus,
a listing of the PCL commands the printer recognizes, a hex chart to
help work through a HEX dump, and references of setting up the
most popular software to work with the printer. The final section
has a list of supplies available for your printer.

Who is this
manual for?
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Unpacking the Printer

As you remove the boxes contents, check the pieces against Unpacking
the £. ine list. -
e following list the Printer

MCHECK LIST

___ 7. Head Print Assembly (ies)
___ 8. Control Box

1. Line Cord
___ 2. Cartridge Capping Station (s)
___ 3. Cable Assembly, Photo Sensor __ 9. Encoder Assembly, OEM
__ 4. Users Manual ___ 10. Ink Cartridge (s)
___ 5. Windows 95 & 98 / NT / 2000 Driver Manuals ___11. Spring Torsion, LH

& 3 V2 Driver Disks .
___ 6.Warranty Information Sheet and Card

OEM USERS MANUAL Section 1 -1
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The following environmental considerations must be kept in
mind when selecting a location for the Industrial Printer.
Doing otherwise may affect the operation and performance of
the Industrial Printer.

1. Place the printer close enough to the computer for the
parallel or serial cable to reach. Note: AB switches are
-~ not recommended for operation with this printer.

2. Place the printer on a flat, stable surface.

3. Use a grounded, dedicated outlet for the printer only.
Note: Do not use an adapter plug.

4. Avoid locations near direct sunlight, excessive heat,
high humidity, moisture, or dust.

5. Keep the entire system away from large motors or

other appliances that might disturb the power supply or

create potential interference.

Before starting to build the OEM there are some issues that

Setting Up the Printer

Choosing a
Good
Location for

the Prikn’ter |

need to be addressed for the OEM to function with your Before you
machinery.
Answer the following questions: Start
o What is the best direction to mount the Control Box;
mount standing up or mount laying down?
o What direction is the media going to traveling under the 3
Head Print Assemblies: From Left to Right or Right to
Left?
o Where can the Encoder Assembly be installed without
being in the path of the media?
o Where is the path the media will travel? Will the media
interrupt the beam of the Sensor Assembly?
o What color is the media? Is it a dark color or light color?
Will the media reflect the sensor beam back? Will the
background the sensor is aimed at reflect the sensor beam
back?
o Does the media have printing on it? Light and dark areas?
Use the following step by step directions to help in setting up
the printer.
Revision D OEM USERS MANUAL Section 2 - 1
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Setting Up the Printer

It is assumed that there is a location and means of mounting
the Control Box, that there is a bracket for mounting the
Sensor Assembly in the path of the media, the Encoder
Assembly will get mounted onto the transport belt, and the two
3 Head Print Assemblies are going to get mounted on a set of

adjustable brackets. .
Setting Up
The first question is how is the Control Box going to be
-~ mounted? Will the Control Box be standing up or willitbe the Control
laying down? Box

The first step is how to change the Brackets on the
Control Box. Do not be alarmed that the LCD display
and the keys are upside down. Later in connecting the
3 Head Print Assemblies the controls will get mounted

correctly.
I
Before getting started you will need a medium Phillips Brucke\‘\ [ Bracket
head screwdriver for mounting the OEM and
. . Brackets on Control Box
assembling the printer. as mounted at factory.

The Control Box has four holes on each side for installing the

brackets. The Control Box already has the brackets

installed at the factory so the Control Box will stand Screws &
upright. o

1. To change the Brackets use the Phillips head
screwdriver to remove the two screws from
each of the brackets.

2. Reinstall the brackets on both sides of the
Control Box using the two screws.

Once the brackets are installed onto the Control Box
then secure the Control Box in place by using screws
or clamps.

Bracket installed on/

side of Control Box.

Revision D OEM USERS MANUAL Section2 -2
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Setting Up the Printer

Mount the Sensor above the path of the media. The sensor is a
reflective sensor and must be adjusted to recognize the
difference between the media and the transport belt or
background surface. For optimum performance of the sensor,
keep the sensor as close to the reflective surface of the media
or background without it getting bumped or damaged.

- Another consideration in determining where the sensoris
going to be placed is the distance from the first and last Banks
of 3 Head Print Assemblies. Use the illustration below for an
example. The furthest distance the sensor can be from the last
Bank of 3 Head Print Assemblies is thirty-six inches. The
closest distance the sensor can be placed is one half inch from
the first Bank of 3 Head Print Assemblies.

Sensor
Assembly

shows where
Sensor can
be positioned.

Included with the Sensor is a bag of screws and nuts. The parts
in the bag have been included to help you mount the sensor.

Installing
the Sensor
Assembly

Sensor Assembly -

Threaded Cap

Note: Begin measuring
from the middle of the Print
Cartridge to the Sensor
Assembly.

Once the sensor is set into position then
plug the sensor into the port on the side
of the Control Box. Turn the threaded
cap to secure the sensor connector in
place.

Twistio

ok in place.

Make certain the path the media will r =T

of the sensor beam. Use the illustration
to the right for an example.

travel is beneath the sensor or in the path  tewveds

Revision D OEM USERS MANUAL
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Setting Up the Printer

The Encoder Assembly must be installed where it will keep

track of the speed of the media. Mount the Encoder Assembly

with the transport belt trapped between the Large Roller and
the small roller on the swing arm.

A bag of parts are included in the accessories to help in

— mounting the Encoder Assembly and in case the Encoder

Assembly swing arm has to be reversed.

When choosing a place for the Encoder Assembly you must
find an area that is out of the path of moving media or other
moving objects. Place it in an Encoder Safe area so it will not
get bumped or hit by the media. The illustration shown below
is an example of an Encoder Safe Area.

Open the swing arm and place the transport belt between both
rollers. Mount the Encoder Assembly with the rollers placed
onto the belt. Once the Encoder Assembly is set into position
then plug the encoder into the port on the side of the Control

Installing the
Encoder
Assembly

Encoder Assembly

Box. Turn the threaded cap to secure Example of possible locations for the

the encoder connector in place.

The Encoder is able to be mounted to
travel to the right or to travel to the
left. To reverse the direction of the

Encoder Assembly.

Swing Arm on the assembly it may be

removed and reinstalled using the
extra Torsion Spring.

A small Phillips head screwdriver, a

1/8 Allen driver and the bag of

components are needed to change the
assembly.

1. Use a 1/8 Allen driver to remove the Shoulder Bolt and

Swing Arm from the “L” shaped bracket.

2. Remove the two screws securing the “L” shaped
bracket to the assembly.

Reversing the
Encoder
Assembly

3. Flip the assembly over and remove the two screws
from the other side that secures the Felt Bracket.

Swing Arm

N

\\\' / fo "\-"/Brocket "L” shaped.

fFelt Bracket

i

® @

Shoulder Bolt with
—washers and R.H.
Torsion Spring

Revision D OEM USERS MANUAL
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10.

1.

13.

14.

15.

-and washers from the Swing Arm.

Setting Up the Printer

Reinstall the Felt Bracket on the opposite
side.

Mount the bracket for the Swing Arm onto
the other side of the assembly.

Pull the Torsion Spring, the Shoulder Bolt

Felt Bracket

Encoder Shown without

. &// Connector of ease of
« @ illustration.
q .

\Bmcke’ "L" Shaped

Rear View

Reinstall the Shoulder Bolt and washers through the

other side of the Swing Arm.

Install the other Torsion Spring from the plastic bag
into the hole in the Swing Arm and onto the Shoulder

Bolt.

Start screwing only one or two threads of
the Shoulder bolt into the Encoder
Assembly. Do not tighten completely.

Set the roller on the Swing arm onto the
large roller.

Twist the free end of the spring over and

Encoder Shown without

L

™
/ N e . = Connector for ease of
o ® @ d iltustration.
[(® 1
\ ® ®
e

NS

@ ~®.

Remove Swing Arm and
install other Torsion Spring.

v
aos

;\\—Bruckef "L"” Shaped

Side View Rear View

push it into the hole in the bracket.

. Finish securing the Shoulder Bolt in place. The

Encoder Assembly is now ready to be mounted
the transport belt.

Mount the Encoder Assembly onto the
Transport Belt.

Once the Encoder Assembly is set into
position then plug the encoder into the port
on the side of the Control Box.

Turn the threaded cap to secure the encoder
connector in place.

onto

Shown upside down for ease of
illustration,

Rear View

Side View

Revision D
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Setting Up the Printer

Once the Control Box, the Encoder Assembly and the Sensor

Assembly are in position then install the 3 Head Print Installing
Assemblies. the 3 Head
Locate the two 3 Head Print Assembly over the area where the Print

media will travel. Make certain the 3 Head Print Assemblies
will be mounted perpendicular to the path of the media. Use
the two threaded holes on the back for mounting each of the 3
~Head Print Assemblies. Use the same steps when adding
additional Head Print Assemblies.

Assemblies

Recommendation: When positioning the Head Print
Assemblies think of Bank A as the first six lines of a page and
Bank B as lines 7 through 12 on a page. Continue in this
fashion when adding more 3 Head Print Assemblies.

3 Head Print Assemblies

When placing the 3 Head Print Assemblies always stagger the
next one out and up toward the direction of the sensor. Use the
wide wiper in the center of the assemblies as a reference where
the nozzles will be printing. Continue in this manner when
installing any additional ‘ Ml
3 Head Print
Assemblies. Refer to the
illustration on the right — e : —
when placing and * BRI — Lo
labeling the 3 Head o 3 fia
Print Assemblies.

Make certain the wipers
on the 3 Head Print
Assemblies are angled
up on the side that the
media will be coming
from. If the wipers are
angled up where the media is exiting then
you need to reverse the direction of the
wipers. See section “Reversing the Wipers™. =

Opti [
Opﬂonar\\gsgsng
Bank C

1 2000000
1 soponoe ©
fsdelelio1i Tadololed

J socosocon ©

[ulelelelzlolideiviolv] o
BRCOOBROO00

= Media
One of the 3 Head Print Assemblies has i i
wipers that extend up higher than the others. HH
Place this 3 Head Print Assembly toward the .
.. . 3 Head Print
front where the media is coming from. Assembly
Revision D OEM USERS MANUAL Section 2 - 6
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‘Setting Up the Printer

,,,,,,,, ‘§
'Danger!! Serious Electrical Shock May Occur from exposed Connectmg
wires if power cord is connected to the printer. the Head
Print

The last peripherals to connect to the Control =~ Warning: Always wear anti Assemblies
Box are the 3 Head Print Assemblies. Use the ~ Static wrist straps whenever

. working near or handlin o e
- following steps to connect each of the 3 Head . ngéesm Board. ‘Srfﬁc to th,e ;
Print Assemblies. discharge will damage 1C contrOI
Chips. B
OX.

1. Remove the four screws from the Control
Panel. Danger: Disconnect the

: s
power cord from the printer. TN

2. Lift the Control Panel up and
disconnect the cable from the
panel.

Control Panel

Screws~§~

3. Remove the four screws from Screws to Cover
the Cover. Lift the Cover from
the Control Box.

| e : ®
1 4. Locate the four slots on top ﬁimt%e Cf:rf’rrg?rggil‘ Panel firs
right corner of the processor
board. Connect the Head Print Assembly that is located . A
the farthest from the COn.troI Box into the slot marked mz:;:%g:tﬁ?%ﬁf;hfzgwr
Print Head | (Refer to this 3 Head Print Assembly as installation of the 3 Head Print
Bank A). Connect the next furthest from the Control Assemblies.
Box into the next slot up. The slot is marked as Print
Head 2 (Refer to this 3 Head Print Assembly as Bank
B). Continue in this fashion to add
more 3 Head Print Assemblies.

5. Locked near the Transformer is a
black metal bracket with a Strain
Relief Bar screwed down. Remove
the screw securing the Strain
Relief Bar and lift and unhook the
bar from the bracket.

Strain Relief
Bar

6. Lay all the cables from the Head
Print Assemblies down. Caution: Do not fold or crimp
the ribbon cables. Damage may occur to the cables

Revision D OEM USERS MANUAL Section 2 -7
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SettingﬁﬁUP the Printer

when folded or crimped which may result in poor or
lost print.

7. Hook the Strain Relief Bar into the bracket.
8. Lay the bar over the cables and secure with the screw.

9. Reinstall the cover onto the Control Box usmg the four
SCrews.

10. Reconnect the cable to the Control Panel.

11. Reinstall the Control Panel onto the Control Box using
the four screws. Orient the Control Panel for the
Control Box laying down or standing upright.

Up to this point the setup for the printer is to run it in a Right
to Left direction. The following steps are the required changes _
to run the printer in a Left to Right direction. Printer Left

to Right

Running the

1. Setup the Control Box. (See Setting Up the Control Box
for more details).

ScreWS\/ ‘

Bkaet\ . [Brucksf %@ Brockefs
9 .
Set at factory. Optional Setup.
Revision D OEM USERS MANUAL Section 2 - 8
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Setting Up the Printer

2. Install the Sensor Assembly. (See Installing the Sensor
Assembly for more details)

Twist to lock in place.

3. Install the Encoder Assembly. (See Installing the Encoder

Assembly for more details).

/|

e L1 1
lencoder Safe Area
. Medic mp ®  FPafh of

the Media

~ Example of possible locations for the
Encoder Assembly.

4. Reverse the Wipers to run Left to Right.

Reverse the direction of the wipers on each of the 3 Head Print

Assemblies when running the media in a Left to Right
direction. The angled end of the wipers must be

on the same side of the 3 Head Print

Assemblies as where the media is coming from.

Place the angled end of the wipers on the same

side of the Head Print Assembly that the media

is coming from. Use the following procedures

to reverse the wipers.

Use a 1/16 Allen driver to change the assembly
wipers on the 3 Head Print Assembly. Change
each of the 3 Head Print Assemblies wipers.

Reversing
the Wipers

Screws/

Bottom View
Set for Right to Left

Revision D
P/N 90-00501-001
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1. Use an Allen driver to remove the screws
from the three wipers.

2. Flip the 3 Head Print Assembly onto the
other side.

3. Reinstall the wipers with the angled end
. Bottom View
facing up. o S Set for Left to Right

Bank A” Bank B Optional \ Optional
Bank C Bank D

4. Install the 3 Head Print Assemblies.

5. Connect the Head Print Assemblies to the Control Box.

Danger!! Serious Electrical Shock May Occur from exposed
wires if power cord is connected to the printer.

Warning: Always wear anti
static wrist straps whenever
working near or handling

The last peripherals to connect to the Control Box are the 3
Head Print Assemblies. Use the following steps to connect

each of the 3 Head Print Assemblies. the Processor Board. Static
discharge will damage 1C
1. Remove the four screws from the Control Panel. Chips.

Danger: Disconnect the power cord from the printer.

Revision D OEM USERS MANUAL Section 2 - 10
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Setting Up the Printer

2. Lift the Control Panel up ScreWSNW

and disconnect the cable
from the panel.

/Conirol Panel

3. Remove the four screws

from the Cover. Lift the Cover
Cover from the Control Serews fo Cover | 'l

4. Locate the four slots on top LS - P
righ[ corner of the Remove the Control Panel first

on the Control Box.

processor board. Connect

the Head Print Assembly that is located the farthest
from the Control Box into the slot marked Print Head 1
(Refer to this 3 Head Print Assembly as Bank A).
Connect the next furthest from the Control Box into
the next slot up. The slot is marked as Print Head 2

Warning: Disconnect the power
from the Control Box before
installation of the 3 Head Print
Assemblies.

(Refer to this 3 Head Print

Assembly as Bank B). Continue in
this fashion to add more 3 Head
Print Assemblies.

5. Locked near the Transformer is a
black metal bracket with a Strain
Relief Bar screwed down. Remove
the screw securing the Strain
Relief Bar and lift and unhook

Strain Relief
Bar

from the bracket.

6. Lay all the cables from the Head Print Assemblies
down. Caution: Do not fold or crimp the ribbon
cables. Damage may occur to the cables when folded
or crimped which may result in poor or lost print from
the OEM.

Revision D OEM USERS MANUAL
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Setting Up the Printer

7. To print on the media moving in a Left to Right

direction the settings of the DIP Switches on the Left to

processor board must be changed. The DIP Switches

are located toward the lower Right corner of the Right DIP

processor board. The DIP Switches are all set to ON at Switch

the factory for print Right to Left. Set switch #1 to OFF .

when the transport system is Setting

going to move the media from . S
DIP

Left to Right.

Switches
8. Hook the Strain Relief Bar
into the bracket.

9. Lay the bar over the cables ' — e
and secure with the screw. ) e i

pi g 1
12349567 8]

10. Reinstall the cover onto the
Control Box using the four
Screws.

11. Reconnect the cable to the Control Panel.

12. Reinstall the Control Panel onto the Control Box using
the four screws. Orient the Control Panel for the
Control Box laying down or standing upright.

Revision D OEM USERS MANUAL Section 2 - 12
P/N 90-00501-001



Trying Out the Printer

The power cord is plugged in, the printer is connected to the Power On
computer. Now you can turn the power on.

Press on the printers' ON/OFF (I/0) power
switch. The switch is located on the side of the
_printer next to the line cord receptacle. Press on
“the symbol "I" (ON) position. The printer LCD

menu will display the initializing phrase
PRINTER STARTING 1 then PRINTER
STARTING 2 and printer will automatically go

ON LINE.
an <
-~ 00000/Hr Exec
0007 spd 0 pcs o
On-Line Test Menu Enter
LI | -
; | Il I | | I
ﬁ 1=

The Industrial Printer uses one, two, three and up to twelve
black Print Cartridges for printing. To install the cartridge, do
the following:

Verify the LCD on the top of the ON LINE button is
lit. The LCD is either unlit for OFF LINE or lit for ON

LINE.

Revision D OEM USERS MANUAL Section 3 - 1
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Trying Out the Printer

eep new and used cartri gesk
out of reach of children. Discard empty print cartridges in the proper manner.

Installing a
1. Remove the Cartridge from the Print
shipping container by peeling top Cartridge

cover off. Be careful not to touch

the copper ribbon.
Note: The OEM was

designed to use a HP
51645 style print
cartridge or HP

) 51645A Ink
2. Gently remove both pieces TAPE Reservoir System.

of tape covering the ink
nozzles on the print
cartridge. Be careful not to
touch the copper nozzles.

3. Raise the latch all the way
up on the Head Print Assembly. Hold cartridge from
the notched handle on top of the cartridge. Gently
insert cartridge down at approximately a 45 degree
angle into the cradle.

4. Push down on the ink cartridge until it is seated on the
bottom of the Head Print Assembly. Push and
rock the ink cartridge forward to stand ink
cartridge up. Press down blue latch to lock ink
cartridge in place.

Revision D OEM USERS MANUAL Section3 -2
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Trying Out the Printer

When the Ink Low LED indicator is
blinking the Print Cartridges are nearly
empty and have to be changed soon. Use
the following steps to remove used or
damaged Print Cartridges.

1. Grasp the latch on top. Lift up on
the latch. The cartridge will “pop’
loose.

b4

Removing
the Print
Cartridge

Ink Low

LED )NDICATD
7,

2. Grasp the handle on the ink cartridge and lift the print

cartridge out of the cradle.

Note: Reset the Ink
Count in the Main
Menu after replacing a
Ink Cartridge.

Revision D
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Trying Out the Printer

Recheck that all the necessary components of the printer are

installed and fastened. Preparing
e Is the Sensor and Encoder Assembly securely plugged in? the Media
e Are the 3 Head Print Assemblies installed and locked in
place?
e Does the printer have at least three black print cartridges
 installed?

~ & Is the printer connected to the computer? -

Now that all the parts of the printer are installed the printer
needs to be adjusted to work with the media. To avoid
problems of misfeeding and jams the media must also be made
ready for the printer.

Use the following steps to make the media ready for printing:

1. Take a manageable pile of media and while holding
them (as shown below in reference A), "fan" all sides
of the media to make sure that each piece of media is
free from one another.

2. Square the pile against the tabletop, assuring a square
pile on all sides. (Reference following illustration) This
will also allow media to settle toward the bottom of a
stuffed envelope making the media a consistent shape.

Fan All Sides of Media Square Media
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The printer is designed to print on a variety of media with
various finishes and coatings. The sharpness of the print
quality will vary with different media types, depending on how
absorbent the media is, as well as other qualities. The best
results can be achieved using white wove bonded stock. The
printing quality will be less sharp on tyvek, recycled and
glossy media.

~To start a print job the gap between pieces should be set
according to several variables. The first variable is the print
quality that is chosen. The higher the print quality, the more
ink that gets sprayed which requires lowering the transport belt
speed.

Note: For the best quality of print with a standard print
cartridge keep the transport belt running at the 100% spd
mark.

The second variable is the amount of data; graphics, records,
return address, etc., which the printer is required to print on
each piece of media. The more that has to be printed on each
piece requires a larger gap before the printer is ready to receive
the next piece.

Example: You have a label setup that is capable of sending 6
lines of data. Some records only have enough data to utilize 3
or 4 lines of the label, while others will utilize all 6 of the lines
available. The feed rate should be determined by running a test
file containing all 6 line records to ensure that no early feed
errors are encountered.

Perform the subsequent steps for running the OEM using #10
envelopes. In the example a generic conveyer system with a
variable speed control and an adjustable media feeding system
are used.

Trying Out the Printer

Setting the
Proper
Feeding
Gap

Setup with
#10
Envelopes

1. Turn on the OEM printer.

2. Start the conveyer. Increase the speed of the
transport belt while watching the display on the
Control Box. Increase the speed until 100 %

00000/Hr Exec
1007 spat 0 pes.

Onime  Yest Menu  Enfer

ME BEE

spd is shown on the LCD display.

3. Put the prepared #10 envelopes into the feeder.
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Trying Out the Printer

The printer is designed to print on a variety of media with
various finishes and coatings. The sharpness of the print
quality will vary with different media types, depending on how
absorbent the media is, as well as other qualities. The best
results can be achieved using white wove bonded stock. The
printing quality will be less sharp on tyvek, recycled and
glossy media.

- To start a print job the gap between pieces should be set -
according to several variables. The first variable is the print
quality that is chosen. The higher the print quality, the more
ink that gets sprayed which requires lowering the transport belt

speed. Setting the
Note: For the best quality of print with a standard print Proper
cartridge keep the transport belt running at the 100% spd Feeding
mark.

Gap

The second variable is the amount of data; graphics, records,
return address, etc., which the printer is required to print on
each piece of media. The more that has to be printed on each
piece requires a larger gap before the printer is ready to receive
the next piece.

Example: You have a label setup that is capable of sending 6

lines of data. Some records only have enough data to utilize 3 Setup with
or 4 lines of the label, while others will utilize all 6 of the lines #10
available. The feed rate should be determined by running a test
file containing all 6 line records to ensure that no early feed
errors are encountered.

Envelopes

Perform the subsequent steps for running the OEM using #10
envelopes. In the example a generic conveyer system with a
variable speed control and an adjustable media feeding system
are used.

1. Turn on the OEM printer.

00000/Hr Exec
1007 spd 0 pes

2. Start the conveyer. Increase the speed of the
transport belt while watching the display on the o —
Control Box. Increase the speed until 100% f HE 8HE =
spd is shown on the LCD display.

3. Put the prepared #10 envelopes into the feeder.
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Trying Out the Printer

4. Send several copies of the test record to the OEM.
Start by sending ten or more copies of the test record to
the OEM when setting the gap. Note: Use the record
with the most lines as the test record.

5. Start feeding envelopes to the conveyer. Starting with a
gap of a quarter of an envelope.

6 Check the diéplz{y on the OEM for R

i
any Early Feed Error messages. §§ | §§ e
88 84 g8 8
Line 1 Line 1 “ gg §§
. Line @ Line 2 69
7. If no errors are seen and every piece tne 7 e 7 -
e . B . Line 5 Line 5 i
is printed on then the gap is good. et = |

Start decreasing the gap to increase
the throughput. Stop as soon as

Early Feed Errors are detected. Fach piece is printed on
when right gop is set.

Bank A

8. If Early Feed Errors are detected

then start increasing the gap between pieces. Keep
increasing the gap until every piece is printed on and
no errors are detected.

9. The OEM is now ready to run a job of #10 envelopes.

00009000
008TACO0

fl | so0a000
[ sooc000 ©
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Printer Tips

Different sizes and types of media call for unique settings of Finding the Right
the Head Print Assemblies. To accommodate different sizes of Height

media the Head Print Assemblies have to be raised or lowered .

until they touch the top of the media. Enough pressure has to Adjustment for

be applied by the metal wipers underneath the Head Print Media Thickness

Assemblies to keep the media from moving around beneath

the Print Cartridges while printing.

1. While the OEM printer is
printing, lower the Head Print
Assemblies until the wiper
under the Head Print
Assemblies just touches the
media. When the printed test
message smudges, adjust the
Head Print Assemblies up to
get the desired print quality.
Reference figure to the right.

Note: The Head Print
Assemblies are to low
when the print looks
smeared or clumped
together.

Lower towards media.

3 Head Print Assembly

Wipers

Media

N

i!!ail!i_‘ jj

!

|
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Printer Tips

Each bank of three Print Cartridges has to be synchronized to Synchronizing
print graphics, scaleable fonts or just to justify the left edge of new Print
print. If the Print Cartridges are not synchronized anything that . .
requires two or three Print Cartridges to line up a left edge or Cartridges in
to print next to each other may print to the left of one another the Head Print
or on top of each other. When installing a new print cartridge A

A ; . ssembl
or cartridges into a 3 Head Print Assembly it may need to be y
- realigned with the other print cartridges. Synchronizing the
print cartridges in the Head Print Assemblies is accomplished
using the Service Menu option Adjust Print.

The following procedures will refer to the left
3 Head Print Assembly as Bank A, and the
right 3 Head Print Assembly as Bank B.
Synchronize each Bank of Print Cartridges by
aligning the Test Pattern that is printed by
each of the Print Cartridges. Each Print
Cartridge will print a Test Pattern like the one
below.

I [l Head2Banka

Each carriage uses the leftmost Print Cartridge of the three to
synchronize the other two Print Cartridges. Counting from left
to right, the leftmost Print Cartridge in Bank A is referred to as
Head 1 and the leftmost Print Cartridge for Bank B is referred
to as Head 4. For each additional bank of 3 Head Print
Assemblies added increment the count by three. The series
would be Head 1, Head 4, Head 7, and Head 10.

The Test Pattern for a bank of Print Cartridges should look
like the following example when all three print cartridges are Note: [lave several
Synchronized pieces of media to use

when synchronizing the

Print Cartridges.
/ Head 1 Bank A g’

/s
Head 2 Bank A
Head 3 Bank A
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Printer Tips

When lines of print start to run on top of each other the Print "
Cartridges have to be synchronized vertically. Perform a Vertically
Vertical adjustment whenever the center of the Test Pattern Synchronizing
isn’t a solid crooked line. Work down from Head 1 on Bank A a Bank of
or Head 4 on Bank B. .
following steps are an example of how to synchronize Print
The following s roni -
~ Print Cartridges for Bank A. The same steps are taken for Cartridges
~ vertically synchronizing Bank B or any additional banks. R
Example:
In the example below the crooked line in the center indicates
Print Cartridge #3 has to have the printer perform a vertical
print adjustment.

Use the following steps to adjust Print Cartridge #3:

e Accessing the menu can only be accomplished in the
OFF LINE mode.

e  When in ON LINE mode press the [On Line] button.
) Once OFF LINE the service menus are accessible.
? Press the [Menu] and [-] (Minus) button
simultaneously until SERVICE MENU appears on the
LCD display in about two seconds.

e Press the + or = buttons to scroll through the Service
Menu options until the 1. ADJUST PRINT option is
displayed on the LCD panel.

e Press the [Enter] button to select this option.

e Now print out a Test Pattern by pressing the [Test]
button. The printer will print a Test Pattern like the
following example:

Head 1 Bank A

Head 2 Bank A
| / Head 3 Bank A

Revision D OEM USERS MANUAL Section 4 -3
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Printer Tips

The example shows Print Cartridge #3 is to high.

Press the [+] or [=] buttons to scroll through the
Adjust Print menu options until the HEAD 3 UP
DOWN option is displayed on the LCD panel.

Press the [Enter] button to select this option.

Press the [+] (UP) button to increment the horizontal
line value on the LCD display.

Press the [-] (DOWN) button to decrease the horizontal
line value on the LCD display.

Press the [Enter] button to select the desired value. An
Asterisk (*) will appear in front of the new selection.

Press the [Test] button to print another Test Pattern.
This time the Test Pattern is printed using the entered
selection. The pattern printed should look like the
following example:

7 Head 1 Bank A
: Head 2 Bank A
Head 3 Bank A

L

When the correct numeral is selected the center test pattern
will be one long crooked line.

[ J

Press the [Menu] button several times to back out of
the Service Menu.

Press the [On Line] button; now the printer is ready
for use.

Revision D
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Printer Tips

When a line of print is split apart or the left edge of a block of
lines don’t line up with the left edge of the other lines the Print
Cartridges have to be synchronized horizontally. Perform a
Horizontal adjustment whenever the large solid line and the
set of 18 thin vertical lines do not form long vertical lines for
the whole bank of Print Cartridges.

The following steps are an example of how to synchronize

~ Print Cartridges for Bank A. The same steps are taken for

horizontally synchronizing Bank B and any extra banks of
Print Cartridges.

Example:

In the example below the large vertical line on the left and 18
thin vertical lines indicate Print Cartridge #2 has to have the
printer perform a horizontal Print Adjustment.

Use the following steps to adjust Print Cartridge #2:

¢ Accessing the menu can only be accomplished in the
OFF LINE mode.

e When in ON LINE mode press the [On Line] button.
Once OFF LINE the service menus are accessible.
Press the [Menu] and [-] (Minus) button
simultaneously until SERVICE MENU appears on the
LCD display in about two seconds.

e Press the [+] or [ -] buttons to scroll through the
Service Menu options until the 1. ADJUST PRINT
option is displayed on the LCD panel.

e Press the [Enter] button to select this option.

e Now print out a Test Pattern by pressing the [Test]
button. The printer will print a test pattern like the
following example:

The example shows Print Cartridge #2 is to far to the right.

Horizontally
Synchronizing a
Bank of Print
Cartridges

Revision D OEM USERS MANUAL
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Printer Tips

l Head 1 Bank A
| Head 2 Bank A
7{ | Head 3 Bank A

-

Lo

e Press the [+] or [-] buttons to scroll through the
Adjust Printing menu options until the HEAD 2 SIDE
TO SIDE option is displayed on the LCD panel.

e Press the [Enter] button to select this option.

e Press the [+] (LEFT) button to increment the
horizontal line value on the LCD display.

e Press the [-] (RIGHT) button to decrease the horizontal
line value on the LCD display.

e Press the [Enter] button to select the desired value. An
Asterisk (*) will appear in front of the new selection.

e Press the [Test] button to print another test pattern.
This time the test pattern is printed using the entered
selection. The pattern printed should look like the
following example:

Head 1 Bank A

Z Head 2 Bank A

Head 3 Bank A

AN

When the correct numeral is selected the large line and the set
of 18 vertical lines form long vertical lines down the entire
Bank A of Print Heads:

Revision D OEM USERS MANUAL
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Printer Tips

e Press the [Menu] button several times to back out of
the Service Menu.

e Press the [On Line] button; now the printer is ready
for use.

The two or more Banks of print cartridges can be combined Using the
_and used as one large block of print heads. This is best done T

for large fonts and big graphics or two dimensional bar- Head Print

coding. To synchronize two or more 3 Head Print Assemblies Assemblies

together requires mechanically adjusting the banks together

and using the menus to horizontally synchronize the banks Together.

together.

The Service Menu will adjust the print head Bank B to Print

Bank A to synchronize the when the large and the set of 18

vertical lines do not form long vertical lines. Perform the

following steps to synchronize Bank A and Bank B and any
- extra banks of Print Cartridges.

The following graphic shows when the two banks need to be
synchronized using the Service Menu.

The mechanical adjustment to combine Bank A and Bank B Adjust the
has to be done before both carriages can be synchronized. .
Head Print

Head 5 Bank B
Head 6 Bank B

Head 5 Bank B
Head 6 Bank B

N

/ Head 1 Bank A 7 Head 1 Bank A Assemblies to
Head 2 Bank A ; , I ' Head 2 Bank A Print
Head 3 Bank A Head 3 Bank A Together.
Head 4 BankB J§ /7 NH Head 4 Bank B

AN

3
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Printer Tips

Example: Use the following steps to adjust the two 3 Head Adjusting the
Print Assemblies together. Banks together

1. Move the 3 Head Print Assembly to the area that Bank
A will be printing on the piece.

2. Secure Bank A in place. In this example the other Bank
~of print cartridges are going to get set
relative to Bank A.

3. Move the front of the right Head Print
Assembly (Bank B) 1.5 inches forward
from Bank A.

[ oo0et0000
i 000060000 °©

4. Print out a Adjust Printing test
message.

5. Make adjustments by moving Bank B in or out. When
the Adjust Printing test pattern makes a solid pattern
across both banks then level the banks to make certain
they are both the same height.

6. Secure the right 3 Head Print Assembly (Bank B) in
this position.

Lay a ruler or
straight edge to

level the 3 Head
Print Assemblies.

Note: The same steps are used whether adjusting
2 or more banks of print cartridges together.

| e || S|
BN || .

| ||

i -
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Printer Tips

o

The two 3 Head Print Assemblies need to be synchronized . =
using the Adjust Print menu when the Test Pattern looks like sy“‘:hro“'mng
one of the two examples below. 3 Head Print

Assemblies

Head 1 Bank A
Head 2 Bank A
Head 3 Bank A
Head 4 Bank B
Head 5 Bank B
Head 6 Bank B

Head 1 Bank A
Head 2 Bank A
” ‘Head 3 Bank A

7 I Head 4 Bank B
Head 5 Bank B
Head 6 Bank B

The Adjust Print menu has to be used when synchronizing the
two banks together. For more information about the Adjust
Print menu see the section in the Service Menu.

e Press the + or = buttons to scroll through the Service
Menu options until the 1. ADJUST PRINT option is
displayed on the LCD panel.

e Press the Enter button to select this option.

e Press the + or = buttons to scroll through the Adjust
Print menu options until the Bank B to Sensor option is
displayed on the LCD panel.

e Press the Enter button to select this option.

e Now print out a Test Pattern by pressing the Test
button. The printer will print a Test Pattern like the
preceding example.

The Test Pattern consists of three rows of different patterns,
the first wide line and the eighteen vertical lines are used for
synchronizing Bank A and Bank B.

When the two patterns do not match to form long vertical
lines, then perform the following steps.

Revision D OEM USERS MANUAL Section 4 -9
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Printer Tips

e Press the +(MORE) button to increment the Move
Bank B value on the LCD display.

e Press the - (LESS) button to decrease the Move Bank
B value on the LCD display.

e Press the Enter button to select the desired value. An
Asterisk (*) will appear in front of the new selection.

e Now print out a Test Pattern by pressing the Test
button. The printer will print another test pattern. This
time the test pattern is printed using the entered
selection.

The pattern printed should look like the following example:

|| Head 1 Bank A
Head 2 Bank A
Head 3 Bank A
Head 4 Bank B
Head 5 Bank B
Head 6 Bank B

SN

When correct all lines should be straight.

¢ Press the Menu button several times to back out of the
Service Menu.

e Press the On Line button; now the printer is ready for
use.
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Printer Tips

The 3 Head Print Assemblies have several holes for relocating
the two narrow Wipers. Move the wipers when synchronizing
banks of print cartridges or when two or more banks of print
cartridges are printing near each other.

Pay special attention when using the left Head Print Assembly
_ with the right Head Print Assembly. If the wipers run over an
- area on the media where ink was just sprayed the print will

smear or smudge. The area where ink is sprayed onto
the media is referred to as a Print Zone. Use the wide
wiper located on the right Head Print Assembly to
judge where the Print Zone for Bank B is located.
Move the Wipers to an area outside of the Print Zone
to maintain the best print quality.

Perform the following steps to move the Wipers:
1.

Note: Move the Wiper(s) far off to the side .

if one or both are running along the edge of .
the piece or just off the edge. This may —
cause skewing of the print or paper jams.

Moving the
Wipers

Put the right Head Print Assembly and the

Bank " A

1.5

left Head Print Assembly in the proper location to print
on the piece of media.

Locate on the right Head Print Assembly the Print
Zone. The wide wiper on the Head Print Assembly
gives an approximate location of where Bank B is
going to print.

Remove the two screws securing the Wiper on the left

Head Print Assembly (Bank A).

Relocate one or both wipers away
from Bank B’s Print Zone. Reinstall
the wiper on Bank A without
placing in the path of the Print Zone

of Bank B.

Relocate wipers when
positioned in a Print Zone.

xHoles for wipers

Bottom View
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Printer Tips

Included in the Accessories are Cartridge Capping Assemblies
to enclose the nozzles of the print cartridges. Proper use of the

Cartridge Capping Assemblies help in
maintaining the quality of print from the print
cartridges and help to prevent the ink from drying
and creating severe clogging of the print cartridge
nozzles.

Use the Cartridge Capping Assemblies when the
OEM Printer is left to idle or shut down for a

more than a few minutes. To use the Cartridge Capping
Assemblies the ink cartridges have to be removed from the 3
Head Print Assembly. Note: Keep the ink cartridges in order
or numbered otherwise the counter for the percent ink
remaining will give false information.

Employ the following steps to use the Cartridge Capping
Assemblies.

1.

Remove the ink cartridge from the Head Print

Assembly. (See section 3-3 for information on
removing the ink cartridges.)

Remove any excess ink on the nozzles.

Install the ink cartridge nozzle first into the Cartridge
Capping Assembly. Note: Clean any ink buildup on the
rubber seal to prevent it from obstructing the nozzles.

Press the top section completely into the Cartridge
Capping Assembly.

Remove the ink cartridge from the Cartridge Capping
Assembly in reverse order. Suggestion: Check the
Print Head Alignment and perform a Purge of the ink
cartridges before operating the printer.

Prolonging
the life of
Print
Cartridges

Revision D OEM USERS MANUAL
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Printer Tips

Factors that Affect the Printers Performance

The OEM Industrial Printer is designed to give the best
possible performance, but the speed can be affected by these

factors.

L

w

N o ok

8.

Whether the printer is running on serial or parallel

connection with the computer.
The amount of memory available in the computer.

Whether the printer is running as a network printer
or with a print spooler.

Dark colored material or printed graphics.
Pre-glued flaps on the media
Glossy or heavily waxed media.

Setting up margins, or sending non printable
characters or blank spaces in the records.

Sending blank lines in each record.

Tips for Running the Job

Affects the
performance
of the
Printer

1. Connect the printer to the computer with a parallel
interface cable.
2. Use a computer dedicated to the printer only.
3. Tab magazines or stapled sheets.
4. Eliminate blank spaces and lines in the records.
Extra characters take extra time to process.
5. Records with differing numbers of lines should be
followed with a page break or form feed.
Revision D OEM USERS MANUAL Section 4 - 13
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Adjusting the Sensor

The Photo Sensor Assembly has been adjusted at the factory to
operate with plain white media against a black background.
Before using colored or preprinted media it is best to check the
sensors sensitivity to the media and background first. Check
by slowly moving the media beneath the sensor. Confirm the
red and green LED simultaneously turn on when the media is
underneath and turn off when the media is removed. Check
~that the belt or background surface will not trigger the red and
green LED’s on the sensor.

Depending on the type of media being used it may be
necessary to adapt the sensor to the media by moving the
sensor to a more reflective area on the media or by adjusting
the sensors to respond to the reflectivity of the media. Note:
The position that each record is printed may vary. This is due

Checking the
Photo Sensor
Assembly

'Repositioning
the Photo
Sensor

to the sensor being adjustable. Print a test to
ensure the positioning of the 3 Head Print
Assemblies.

The easiest solution for using media that is

colored or pre-printed is to move the sensor

over to an area where it will operate correctly bt L we— : g
d' d h S h Path of Area Cigar of | Area Clear of !
; Print € pini L
as the media passes underneath. secure the  the Medit o eo—
sensor in this place. Position sensor over the area "

without print or graphics.

If moving the media under the sensor does not
turn the red and green LED on or off simultaneously then
adjusting the sensor will have to be done.

LED Indicators

Red Output Indicator

The red LED lights when enough light is received for it to be
energized.

Setting the
Photo Sensor
to work with
Light Colored
Media against

Green Al Ind a Dark
reen Alignment Indicator
g Background
The green LED lights when enough light is received to
operate. The green LED aids in setting the photo sensor to the
media.
Revision D OEM USERS MANUAL Section 5 - 1
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Adjusting the Sensor

Two things are needed to tune the Photo Sensor. 1) One piece
of media. 2) A small blade screwdriver. Use the small blade
screwdriver to rotate the rotary switch.

When the Red LED is ON and the Green is

OFF

~ Use the following steps to tune the Photo Sensor.

1.

Place the piece of media being used underneath the
photo sensor.

Check that the red LED is illuminated and the green is
off.

Turn Sensitivity Adjustment Rotary switch clockwise
till the green and red LED are illuminated.

Turn Sensitivity Adjustment Rotary switch counter
clockwise 1/2 turn.

Remove the media, then replace under sensor to check
the sensitivity of the sensor. Is the green LED off?
Yes, then continue, otherwise repeat Steps 3 & 4.

Turn Sensitivity Adjustment Rotary switch clockwise
1/2 turn.

Green Alignment —

Indicator . .
- LO/DO Switch
(Media Present) N o / e
®l)0§ I TV
g &, Sensitivity
Recl:i dQufF;uT ocijus?menf
ndicator .- rotary
(Media present) 15 Turn.

Check the sensitivity of the sensor. Remove the media,
then replace under sensor. Check that both the red and
green LED are illuminated. Is the green LED off? Yes,
then repeat Step 1 through Step 6.

Fine tuning
the Photo
Sensor

Note: The LO/DO
Switch has been set to
LO at the factory.
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_Adjusting the Sensor

When the Red and Green LED are OFF.

Use the following steps to tune the Photo Sensor.

1. Place the piece of media being used underneath the Note: The LO/DO
Switch has been set at

photo sensor. the factory to the LO
setting.
2. Turn Sensitivity Adjustment Rotary switch clockwise
till the red and green LED are illuminated

3. Turn Sensitivity Adjustment Rotary switch counter
clockwise 1/2 a turn.

4. Remove the media, then replace under sensor to check
the sensitivity of the sensor. Is the green LED off? If
yes, then continue, otherwise repeat Steps 2 & 3.

5. Turn Sensitivity Adjustment Rotary switch clockwise
1/2 a turn.

6. Check the sensitivity of the sensor by removing the
media then replace under sensor. Check that both the
red and green LED are illuminated. Is the green LED
off? If Yes, then repeat Step 1 through Step 6.

When the background is very reﬂecti_ve or lighf it may be Setting the
necessary to adapt the Sensor by setting the switch to DO. The
operation of the green LED and red LED will change when Sensor to
operated in this mode. Only the red LED will light up when work with
media is underneath and the green LED is lit when the Sensor .
is focused on the background. Dark Media
against a
1. CHECK the sensor to make sure the middle switch is briaht
set to the DO position. If not, do so. 9
background
2. Verify the green LED is lit. If the red LED Green Indicator
is lit or none of the LED’s are lit then turn (No media) o
the screw CLOCKWISE until only the =
green LED is lit.
[ s LO/DO Switch
3. Put a piece of the media being used between o ®>  Sensitivity
the sensor and the background. Verify the k ;.Ef‘:,,@;s‘ adjustment
red LED is lit. Note: Go to the System Test Red Indicator = 514 ry
in the Service Menu to check for the (Media present) 15 Turn.
transition of the sensor from p to P.
Revision D OEM USERS MANUAL Section5 - 3
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Adjusting the Sensor

4. Check the sensitivity of the sensor by removing the
media then replace it under the sensor. Check that the
red LED is illuminated. Is the green LED off? If Yes,
then remove the media and check that the green LED is
illuminated and the red is off.

Revision D OEM USERS MANUAL
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Front Panel Controls and LCD Display

Use the controls on the Front Panel Assembly, consisting of six control buttons and an LCD display, to
set up the Industrial Printer for proper operation with the computer system.

The control button definitions are:

On-Line

E 000007 Hi

0007% spd

TExec

0 pcsE

Test

Menu

Enter

L

Press +/- to
Clear Data Buffer

Button

Function

[ON LINE]

Toggles the printer either On Line or Off Line.

Begins printing accepted address data (records) from the computer
or data in the buffer.

Exits the menus with out changing menu settings.

Allows the printer to resume printing after an error occurs.

[TEST]

Prints a internal test message.
Hold down for continuous printing of the test message.

Prints menu settings and internal alignment patterns for the printer.

[MENU]

Press the [Menu] button to access the Main Menu.

Press and hold the [Menu] button for two (2) seconds to access the
Setup Menu.

Depress the [Menu] and [-] buttons to access the Service Menu.

Exit the control panel menus. First press [Enter] to save a menu
setting.

Revision D
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[ENTER] Selects a menu option displayed on the control panel.

Saves a new menu setting. An asterisk (*) will appear to the right of
the value to indicate the new value has been entered.

[+] / [-] Scroll up [+] and down [-] through the menu options.
Enters a YES [+] or NO [-] for a particular menu options.

Use both keys together to clear any data that was sent to the printer
and stored in the data buffer.

What does the display show?

Approximoted pieces

Print Quality
expected al current
speed.
/

00000/Hr

000% spd
/

/%/;F the speec
‘required for o

print quality displayed

\P@ce counter,
Reset after

every run.

Conventions used in the Printer Menu System section.

Bold with brackets is used for the [Menu], [On Line], [Enter], [+] Plus, [-] Minus buttons when they
must be pressed to program or operate the printer.

Special fonts are used to highlight words that appear on the LCD display, and menu options: i.e

Revision D OEM USERS MANUAL Section 6 - 2
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Main Menu

Use this menu to choose the format and style of address printed and for information to assist in
production. Selected menu options from a sub-menu will appear first in the list of options.

Note: The printer driver overrides most control panel settings in the printer. Some of the control
panel settings are also configured in the printer driver.

1. ADDRESS LAYOUT

Use this option to change the page layout for your mail piece.

Menu Items Selections Explanation

A. Distance From Left | 0.00to 13.50 This menu item allows you to change the position of
the record on the media by moving the record away
from the left edge of the media. Distance From Left
is the distance measured from the Left edge of the
media to the first printable character.

Example:

«————— Distance to Right ————»

[XYZ CORPORATION
e— Distance 123 Washington Rcad

from Left Anytown, CT 06470-1234
Ill' ”II ' “Hl ““l “Ill’l'l'llll
A. Distance From 0.00 t013.50 This menu item only appears when the Orientation
Right is set to Invert. Distance From Right is identical to

Distance From Left except the distance is measured
from the Right edge of the media. Note: Setting this
value too low will force long records to get clipped.

B. Distance From Top | 0.00to 3.00 This menu item allows you to change the position of
the record without moving the Banks of Print
Cartridges. The Distance from top is the distance
between the top edge of the media and the base of
the first line of the address. Note: Increasing the top
margin decreases the print area.

B. Distance From 0.00 to 3.00 This menu item only appears when the Orientation
Bottom is set to Invert. The Distance from Bottom is the
distance between the bottom edge of the media and
the base of the first line of the address.

Revision D OEM USERS MANUAL Section 6 - 3
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C. Line Spacing Automatic i This sets the distance between lines of text. It is
31 1 nes / 1 Nch | measured as the number of lines per inch of text.

4 Tines / inch | Note: Whenever changing the point size of the font,
61 1nes / 1 nch use the automatic line spacing option. The printer
8 lines / inch will automatically select the correct setting for the
increased or decreased font size of the characters
being printed.

| D. Orientation , AT G | This item changes the direction that the print
Normal or appears on the media. ‘

Invert Normal prints upright when viewed from the front

of the Head Print Assemblies. edge of the envelope
is located on the same side as the print cartridges
are.

Invert reverses the print 180 degrees. Setting the
printer to Invert does change some of the menu
items.

2. PRINT QUALITY

This option changes the number of dots sprayed to print characters or graphics on the media. Changing
the amount of ink sprayed also affects how fast the Transport Belts are capable of running before the
print becomes deformed. The LCD display will show a new %spd whenever the Print Quality is
changed. These menu items are available in the printer driver and override the control panel settings.

Menu Items Explanation

Executive This is the darkest of the four print qualities, the slowest print speed and uses
the most ink. To get the best print quality in Executive the maximum speed to
run the transport belt is 24 inches per second (ips) or 60 centimeters per
second (cm/sec).

Letter To get the best print quality in Letter the maximum speed to run the transport
belt is 48 ips (121 cm/sec.).

Draft Draft quality will print documents fast and save ink. To get the best print
quality in Draft the maximum speed to run the transport belt is 72 ips (182
cm/sec).

Super Draft This option offers the highest print speed and prints the lightest of the four

print qualities. To get the best print quality in Super Draft the maximum speed
to run the transport belt is 96 ips (243 cm/sec).

3. FONT

Use this option to alter the fonts characteristics: typeface, point size, spacing, stroke weight, and style.
The printer driver downloads Windows True Type fonts and overrides internal fonts selected through the
control panel.

Revision D OEM USERS MANUAL Section 6 - 4
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Menu Items Selections Explanation
A. Name Courier Select the style of font to print the records with.
san serif Many optional fonts are available by installing an
Roman optional font card. The Font card must be installed
Baxter (Font label facing the front of the printer). Turn the
printer power off for 10 seconds or more. Insert the
Hancock font card, then power on the printer to use the
Nitiss oF Forits that- exteral ToRr cagd " o o
are recognized from
the PCMCIA Card slot
will be added to the
end of the list of
selections.
B. Size 410 30 This item changes the size of the internal font.
C. Width Condensed (50%) This item to changes the width of spaces between
Thin (75%) characters and the width of characters. Normal
Normal (100%) (100%) print width is the standard width of
] characters and spaces between characters.
wide (125%) . .
% Thin (75%) and Condensed (50%) will decrease the
Expanded(150%) spacing between characters and decrease the width
of characters.
Wide (125%) and Expanded (150%) increase the
width of characters and spaces.
D. Bold on or Off This item increases the character stroke weight
(thickness of print).
E. Italic on or Off This item refers to the oblique shape of a character.
F. Outline onor Off This item prints only the outline or the edge of the
fonts shape. All the records printed using Outline
will appear as /10/fow text.
4. BARCODE

Use this option to print a USPS (US Postal Service Postnet Barcode) barcode on the piece of media and
to place it above or below the record. For information on the requirements to print a UPSP barcode, see

Appendix G.
Menu Items Selections Explanation
A. Location Above Address Select the US Postal Service Postnet Barcode
Below Address options from the following selections:
Revision D OEM USERS MANUAL Section 6 - 5
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off ABOVE ADDRESS: Prints the barcode in the
address block above the first line of the address on
the media.

BELOW ADDRESS: Prints the barcode below the
last line of the address in the address block on the
media.

OFF : Stops the printing of a Delivery Point
‘1" Barcode (DPBC) on the media. -

Note: This option has the printer generate the USPS
barcode.

B. 5 Digit On/Off ON or OFF This item prints a 5 Digit barcode for a five digit zip
code. Note: Only a 5 Digit barcode is printed for a
five digit zip code when enabled. A Delivery Point
Bar Code cannot be generated from a five digit zip
code.

5. ADDRESS RECOVERY

When something goes wrong while printing use this option to direct the printer to re-print up to 99 of the
last records or to clear the printers memory of all records.

Menu Items Selections Explanation
A. Get Addresses NONE TO RECOVER | This option retrieves up to 99 records from the data
or buffer.
00 t0 99 The display will say 00: and show the first 16

characters of the last address printed. If NONE TO

Press the [Enter] e ) -
RECOVER is first displayed then the data buffer is

button to select the

record and advance empty.
the display to the next
to last record.
B. Clear Memory YES or NO This option removes any data left in the data buffer.

The alternative way to clear data from the Data
Buffer is to press the [+] plus and [-] minus buttons
simultaneously.

6. CLEAR COUNTER

Use this option to clear the piece (batch) counter back to zero.

Menu Items Selections Explanation

YES or NO This option resets the counter to zero on the display.
Select No to leave the current number of pieces
printed (pcs) on the LCD display.

Revision D OEM USERS MANUAL Section 6 - 6
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7. NOT IMPLEMENTED

Not Available at this time.

8. NOT IMPLEMENTED
© Not Available at this time.

9. IMAGE OVERLAY

This menu item is used in conjunction with the W-InkJet overlay printer driver. Use this option to print
redundant text or graphics in the same location on every piece. The Image Overlay option is best used for
printing a company logo and return address.

Menu Items Selections

Explanation

A. Clear Overlay Press Enter to Clear or

Exit

memory.

This option clears the overlay data in the printers’

B. Print Overlay First | Enable orDisable

of the overlay is correct.

This option prints the data sent for the overlay onto
the first piece. Use this piece to verify the location

Revision D
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10. PURGE PRINT HEAD

This menu item is to clean the ink jet cartridge nozzles. The purge process fires all the ink jet nozzles
onto a piece of media to dislodge and clear any dried ink on the print nozzles. Often this will return the
print quality to a normal level.

Menu Items Selections Explanation

Yes or No This item will fire all the nozzles of a print head
| T | onto a piece of media. The printer must be operating
for the nozzles to get purged onto a piece of media.
Note: Once the purge is started the [-] minus button
must be pressed to stop the cycle.

11. RESET INK COUNT

The printer calculates the amount of ink used by each of the Print Cartridges. When the red led on a 3
Head Print Assembly starts to blink it is a signal that one or more of the Print Cartridges is less than 5%
full and it must be changed relatively soon. After new Print Cartridges are installed the Ink Count needs
to be reset to stop the red led from blinking. '

Menu Items Selections Explanation
1,2,3,4,5,6, This item displays the estimated amount of ink
up to 12 remaining in the print cartridge(s).

Press the [+] plus or [=] minus button to scroll
through the print cartridges 2,3,4, etc. When the
desired Print Cartridge number is displayed, press
the [Enter] button to reset the percent ink to 100%.

Note: The calculation used to
Estimoted amount of Ink Print Cartridge # determine the percentage of ink
Eiemmmg Print Cortridge. [ available is dependent on the
p setting of the menu item PRINT
oz ANKCIN HEAD 1+ HEAD SIZE in the SETUP

E/NTER TO RESET /7 MENT.

Press the
Press Enter when a new [[+]1 (plus> or [~ (minus>

Cortridge is installed. button to scroll the
Reset the percentoage to print cartridge
1007 numbers up or down.
Revision D OEM USERS MANUAL Section 6 - 8
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SETUP MENU

The Industrial Printer has a Setup Menu that lets you configure the Industrial Printer so it will function
correctly with the computer and computer software. Use the Setup Menu to also display the menus in
another language besides English. Hold down the [Menu] button for two (2) seconds until SETUP
MENU is displayed on the first line of the LCD. Select the desired menu option when it appears on the
second line of the LCD.

1. PRINT HEAD SIZE
Enable this option for the printer to keep track of the ink usage for the HP 51645A ink cartridges or the
ink reservoir system.

Menu Items Selections Explanation
Normal Capacity | Select the type of Print Cartridge being used with
or Extended the printer. Changing the Print Head Size alters how
Capacity the percentage of ink used is calculated for the menu

item /1. RESET INK COUNT. Nete: The reservoir
system is nine times the volume of a HP 51645A ink
cartridge. ‘

2. NOT IMPLEMENTED

Not Available at this time.

3. LINES PER ADDRESS

Set the number of lines of text the record will consist of when printing onto the media.

Menu Items Selections Explanation

1 to 66 Set the number of lines to match the number of lines
in a record that will be sent to the printer.

4. COMMUNICATIONS

Data is transmitted from the computer to the printer through the parallel port (parallel interface) or the
serial port (serial interface). Note: The current settings of the SERIAL menu are shown to the right on the
LCD display.

Menu Items Selections Explanation
A. Baud Rate 1200 Baud Select the baud rate that matches the computers for
3388 ggag communication over the serial port
Revision D OEM USERS MANUAL Section 6 - 9
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9600 Baud
19200 Baud

B. Parity odd Use the following steps to change the serial
Even communications Parity.
None

C. Word Length 7 Data Bits Use the following steps to change the serial
8 Data Bits communications word length
CR=CR; LF=LF

D. Line Termination

| CR=CR+LF;LF=LF.

CR=CR; LF=CR+LF
CR=CR+LF; LF=CR+
LF

The typical software line termination is |
CR = CR; LF =LF. If your software is
not typical then the Line Termination
can be modified.

5. HEX DUMP MODE

Utilize this option to print the raw ASCII data (HEX Code) that is being sent to the printer.

Menu Items

Selections

Explanation

off or On

Prints the ASCII data being sent to the printer.

The media width must be a minimum of 7 1/2” or
191 mm when running in HEX Mode. The page
orientation, margins and number of lines are defined
by the ADDRESS LAYOUT and
LINES/ADDRESS. The maximum number of
usable lines is 16.

Note: Clear the data buffer before sending data to
the printer.

Revision D
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6. LANGUAGE

Customize the printer to match the keyboard of your printer, convert measurements from inches to
millimeters and translate the menus from English. Most menus that use inches for measurements are
converted to millimeters.

Menu Items Selections Explanation
A. Symbol Set ISO 6 ANSI Match the printers’ International Standards
| ASCII | Organization (ISO) symbol sets and substitution

ISO 69 FRENCH tables to the one used by the software.

ISO 21 GERMAN The printer has International Standard Organization
ISO 4 UK (ISO) language symbol sets to use when printing in
another language. A symbol set contains collections
150 60 %?AI?\‘W / of the symbols and characters that make up a
language. For a listing of the characters for the ISO

Iso 11 SF“JI:?\JD / symbol sets see Appendix D.

ISO 15 ITALIAN
ISO 17 SPANISH

ISO 61 NORw /
DAN

ISO 10 Sweb /
FIN

ISO 16
PORTUGUE
SE

ISO 8859
ROMAN 8
WINDOWS LATIN 1

PC 8
B. Inch / Millimeter o This option converts the printer measurement
Inch or Millimeters system from inches to millimeters and vice versa.
C. Menu Language ENGLISH This option will convert the Main Menu and Setup
ggéméz Menu to their translations in the listed languages.
ITALIAN
SPANISH
DUTCH
POLISH
JAPANESE
Revision D OEM USERS MANUAL Section 6 - 11
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7. DIVERTER CONTROL

The diverter control option sends a signal to the diverter so the piece used for a purge or as a test piece
will be removed from the bundle of printed pieces. To set the diverter control to function properly
requires knowing the size of the media and the distance from the sensor. Note: Press the [Test] button
when in the Diverter Control menus to test the settings for the Diverter Arm signal. The transport belts
must be moving for the Encoder Assembly to measure distance required in the menus.

Menu Items Selections

Explanation

A. Diverter Distance | 50 to 75

| Enter the distance from the sensor to the diverter

arm for the printer to send the signal to remove the
piece with the purge or test message printed on it
from the bundle of records.

Set the distance in inches from the diverter to the
Sensor Assembly. The range from the Sensor
Assembly to the Diverter Arm must be from 50 to
75 inches.

B. Media Length 0.5 to 20.0

Measure the length of the media. The media length
is regarded as the distance between the leading edge
of the piece to the trailing edge of the piece. This
will ensure the media was diverted out of the stack
and not extra pieces from the next batch of records.

Example: If the leading and trailing edge of a 8 V2 x
11 inch piece of copy paper were the 8 ¥2 inches
then the length must be the 11 inch side.

Use a 5 volt DC relay inline with the Accessory Port and the Diverter Arm when connecting to the 5
VDC line [Pin 1] and the Divert Signal line [Pin 2]. Reference the Schematic for the pins to use when

connecting to the Accessory Port.

SCHEMATIC

e 5 VDT
S GND

2 o
Conveyer Speedup —— N

Fepoer S A
Feeder Signal ot

Bivert ¥

8. POSTAL BUNDLE BRK (BREAK)

Use this option in conjunction with a variable speed conveyor to temporarily increase the speed of the
conveyors transport belt. The increased speed of the conveyor will make a noticeable gap between the
finished batch of printed records and the next batch of records being printed. A second option to create a

gap for trays is available.

Revision D
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Menu Items

Selections

Explanation

A. Enable/Disable
Break

OFF

VERT (Vertical)
BREAK MARKER

HORIZ
(Horizontal)
BREAK MARKER

Select the type of command the printer must receive
before it speeds up the conveyor to set a gap
between batches while it is operating.

The HORIZ BREAK MARKER consists of the
repetition of a single character appearing on a single |
line to start the printer to pause

The VERT BREAK MARKER also consists of a
repetition of a single character but the character is
placed on several lines.

Example of using a
series of 3 ‘#
characters in the
Horizontal Break
Marker setting to
pause the printer.

Example of using a
series of 3 ‘#’
characters in the
Vertical Break
Marker setting to
pause the printer.

**************23

XYZ Corporation

123 Washington Road
Anytown, CT 06470-1234

**************23**
XYZ Corporation

123 Washington Road
Anytown, CT 06470-1234

HeoOAE

Menu Items Selections Explanation
B. Bndl (Bundle) Brk | !”#$ % &’ () * +-. | This option sets what character the printer must
(Break) Character / receive before it will momentarily halt working. The
0123456789 list of characters to select from are:
L<=>7@ H#S D &P () F+-./
ABCDEFGHIJ 0123456789
Revision D OEM USERS MANUAL Section 6 - 13
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(Break) Char Count

KLMNOPQRST 13<=>7@
UVWXYZ
ABCDEFGHIJKLMN
OPQRSTUVWXYZ
These characters and symbols range from
[! ASCII (33)] to [Z ASCII (90)] in a ASCII Table.
| C.Bndl (Bundle) Brk |01 to 10 | Set the number of occurrences the character or

symbol must appear in succession before the printer
can send a Postal Bundle Break signal.

D. Bndl (Bundle) Brk
(Break) Con
(Conveyor) Time

0 to 5 seconds

This option sets the amount of time the conveyor
will run at the increased speed thereby widening the
separation between bundles.

E. Tray Brk (Break) '"#9$ % &’ () *+-. | This option sets what character the printer must
Char (Character) / -| receive before it will momentarily halt working. The
0123456789 list of characters to select from are:
c=>7@ 1HS D & ()F+-.1
ABCDEFGHIJ 0123456789
UVWXYZ
ABCDEFGHIJKLMN
OPQRSTUVWXYZ
These characters and symbols range from
[t ASCI (33)] to [Z ASCII (90)] in a ASCII Table.
F. Tray Brk (Break) 01 to 10 Set the number of occurrences the character or

Char (Character) Cnt
(Count)

symbol must appear in succession before the printer
can send a Postal Bundle Break signal.

G. Tray Brk (Break)
Con (Conveyor) Time

0 to 5 seconds

This option sets the amount of time the conveyor
will run at the increased speed thereby widening the
separation between trays.

H. Conveyor Distance

024 to 255

Set the length in inches between the Sensor
Assembly and the conveyor.

Revision D
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R4

L. When to speed up Start of bundle | Set the length in inches between the Sensor
End of bundle Assembly and the conveyor.

The printer will use the measured distance to determine when to send a signal to the conveyor to speed

" up to put a gap between batches of records. Use a 5 volt DC relay inline with the Accessory Port and the

Conveyor when connecting to the 5 VDC line [Pin 1] and the Conveyor Speedup Signal line [Pin 5]. See
the Diverter Control section for the pins to use when connecting to the Accessory Port.

9. AUTO PURGE
Use this option to keep the print heads from drying out before printing.
Menu Items Selections Explanation
A. First Piece Purge Disable or If you have long breaks of twenty seconds or more
Enable before starting another batch of records this option
will purge on the first piece before printing the
records.
B. Timed Purge off This option will purge the ink cartridges at timed
intervals on a piece. Set the time to determine when
0020 - 3600 . .
seconds to purge the ink cartridges.
C. Conveyor on Purge | None Purge the ink cartridges before running the next

batch of records or starting the next tray. Set the
Bundle Break Postal Bundle Break options to have this option
Tray Break purge the ink cartridges and put a separation gap for
easy retrieval

D. Nozzle keep alive Disable This option will keep the ink cartridges from drying
out during printing. The printer will print a pattern
of nearly invisible single dots that print while the
actual address is not being printed.

Enable

Revision D OEM USERS MANUAL Section 6 - 15
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10. STOP ON INK OUT
Use this option to stop the feeder when the ink counter reaches zero in one of the print heads.
Menu Items Selections Explanation
on or Off Set this option to have the printer send a feeder stop

| pulse signal when one of the print heads reaches

zero % ink count. A message on the LCD display
will be displayed and the bank with the empty print
cartridge will have the LED on.

11. ROM REVISION#

This option displays the Firmware Revision installed in the printer and the total number of accumulated
print cycles (maintenance count).

Menu Items

Selections

Explanation

Press the [Test] button
when ROM REV. is
displayed on the LCD.
A list of the Main
Menu and Setup Menu
settings is printed on
two pieces of media.

The LCD display will give a momentary view of the
ROM Revision and the Maintenance count.

Revision D
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Use this menu for adjusting the print heads in each bank, the banks to each other, checking the transport
and sensors and testing the display for proper functionality. The menu options that are preceded with a
star or Asterisk (*) are the printers’ current settings.

1. ADJUST PRINT

~ The fdllc}wing étéps are for synchronizing the Print Cértridges on the 3 Head Pi‘irit‘As‘sefhbly (Bank A)

and the 3 Head Print Assembly (Bank B), and the optional 3 Head Print Assemblies (Bank C & D).
Employ the options Q. BANK A to T. BANK D to help in combining the 3 Head Print Assemblies for
printing together or separately.

Menu Items Selections Explanation
A. Head 2 up 280 t 300 ) . .
down Use options A through H to vertically synchronize
Press the [Test] button | the individual Print Cartridges in Bank A, Bank B
B. Head 3 up . T ; ’ ’
down to print out a Test Bank C or Bank D.
Pattern. Check the
C. "éead, 5 up Test Pattern to
own determine which Print
D. Head 6 up Cartridges are in need
down of Vertical
E. Head 8 up Synchronization.
down
f. Head 9 up
down
G. Head 11 up
down
H. Head 12 up
down

The following is an example of how to synchronize Print Cartridges for Bank A. The same techniques
used for Bank A can be applied to any of the other Banks. :

Example:

Print out an adjust print Test Pattern by pressing the
[Test] button while in the Adjust Print menu. The printer
will print a Test Pattern like the example to the right.

In this example the crooked line in the center indicates
Print Cartridge #3 has to have the printer perform a
vertical print adjustment. The example shows Print
Cartridge #3 is too high.

Head 1 Bank A

Head 2 Bank A
Head 3 Bank A

/
;

U
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Scroll through the Adjust Print menu options until the HEAD 3 UP DOWN option is displayed on the

LCD panel.

Enter the menu option to move the setting down.
Enter the new value into the printers memory. An
Asterisk (*) will appear in front of the new selection.
Press the [Test] button to print another Test Pattern.
The Test Pattern is printed using the entered
__selection.

When the correct numeral is selected the center Test
Pattern will be one long crooked line with hatch
marks like the example to the right.

/

Head 1 Bank A
Head 2 Bank A
Head 3 Bank A

i. Head 2 side 01 to 99

Press the [Test] button

j. Head 3 side | print out a Test

to Side
. Pattern. Check the . L _
k. Head 5 Side | Test Pattern to When a line of print is split apart or the left edge of
to Side a block of lines don’t line up with the left edge of

determine which Print

1. Head 6 side Cartridges are in need the other lines the Print Cartridges have to be
synchronized horizontally. Perform a horizontal
adjustment whenever the wide solid line and the set
to side of 18 thin vertical lines do not form long vertical
lines for the whole bank of Print Cartridges.

to side of horizontal
M. Head 7 side | Synchronization.

N. Head 9 side

to side

0. Head 11 side
to side

P. Head 12 side
to side

. Use the options I through P to horizontally
to side synchronize the individual Print Cartridges in Bank
A or Bank B or the optional Bank C or D.

The following is an example of how to synchronize Print Cartridges for Bank A. The same techniques

used for Bank A can be applied to any of the other Banks.

Example:

Print out an adjust print Test Pattern by pressing the
[Test] button while in the Adjust Print menu. The
printer will print a Test Pattern like the example on
the right.

In the example to the right the wide vertical line on
the left and 18 thin vertical lines indicate Print
Cartridge #2 needs a horizontal print adjustment. The
example shows Print Cartridge #2 is to far to the
right.

Head 1 Bank A
] Head 2 Bank A
Head 3 Bank A

Revision D OEM USERS MANUAL
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__ Printer Menu System

Scroll through the Adjust Print menu options until the HEAD 2 SIDE TO SIDE option is displayed on the
LCD panel. Select this menu item to change the settings.

Press the [-] button to scroll the values down and move Head 2 left.

Press the [Enter] button to select the desired value. An Asterisk (*) will appear in front of the new

selection.

Head 1 Bank A
Head 2 Bank A
Head 3 Bank A

Press the [Test] button to print another Test
__Pattern. This time the Test Pattern is printed using
the entered selection.

When the correct numeral is selected the wide line
and the set of 18 vertical lines form long vertical
lines down the entire Bank A of Print Heads.

Q. Bank A to 00.500 to 36.000 . ) o
Sensor Use this option to set this distance between the

Press the [Test] button | gensor and the first head in each bank.
R. Bank B to to print out a Test

Sensor
s. Bank C to i atte;n. Check the Set each Bank of Print Heads to work together
sensor est Fattern to (synchronized) or to work independently in different
T. Bank D to detI?lr(im:eBW}gfr N locatim}s on tbe media. Chet:k the Test Pattern to
Sensor 25 determine which Banks are in need of
:zdpi:lmtmg on the synchronization or for relocating the position of a

bank on the media.

For ease of illustration the following example will deal with synchronizing Bank A and Bank B together.
It is assumed the Banks of Print Heads have already been mechanically aligned next to each other. The
same techniques used for Bank A and Bank B can be applied to synchronize any of the other Banks.

Example:

Print out an adjust print Test

Pattern by pressing the / Head 1 Bank A Head 1 Bank A

[Test] button while in the

Adjust Print menu. The Head 2 Bank A Head 2 Bank A

printer will print a Test Head 3 Bank A Head 3 Bank A
4

Pattern like the example on
the right. The adjust print Head 4 Bank B Head 4 Bank B
Head 5 Bank B Head 5 Bank B

Test Pattern consists of three
rows of different patterns,
Head 6 Bank B Head 6 Bank B

the first wide line and the
eighteen vertical lines are
used for synchronizing Bank
A and Bank B.

When the two pattern do not match to form long vertical lines, perform the following steps. In the
example to the right the wide vertical line on the left and 18 thin vertical lines indicate Bank B needs a
horizontal print adjustment. Rule of Thumb: Take the distance from the previous bank of print heads

Revision D OEM USERS MANUAL Section 6 - 19
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Printer Menu System

that want to align the next bank with and add 3.5 inches. As an 7 Head 1 Bank A
example if Bank A is 7.000 then Bank B starts at 10.500.
Z Head 2 Bank A

Press the [Enter] button to select the desired value. An Asterisk Z Head 3 Bank A
(*) will appear in front of the new selection.

Head 4 B
When correct all vertical lines should be straight. é ead Bank

Head 5 Bank B

Use this option to check the mechanical and / or electrical operation of the Address Printer.

Menu Items Selections Explanation

Press the [Enter]
button to select this
option. As soon as, the
[Enter] button is
pressed, the printer
will be in the test
mode,

The sensor is represented on the LCD by the
lowercase letter p or the upper case letter P. The
LCD display shows a lower case letter of p (sensor
unblocked) when the sensor is clear. When the
sensor has media in the path the capitol letters P
(sensor blocked) is shown.

3. TEST DISPLAY

Use the test display option to help determine if the LCD display is not functioning properly i.e. missing
characters, strange characters, missing segments, etc.

Menu Items Selections Explanation
Press the [Enter] The test display will scroll characters across the top
button to select this and bottom of the LCD display.

option. As soon as, the
[Enter] button is
pressed, the printer
will be in the test
mode.

EXAMPLE:

The LCD display will scroll the lower case alphabet and numerals
(0-9) across the top line, while the bottom line will scroll control
characters and the numerals. The Test function will cycle twice and
return to the Service Menu. See example below for LCD display
sample test message.

abcdefghijklmnopgrstuvwxyz 0123456789
\->#$%&*()_+- =[]:;'<>/? 0123456789

defghijkImnopgrstuvwxyz 01
1#$%&*(Q_+- =[]1:;"'<>/?7 012

Example of LCD display with
characters scrolling across

Revision D OEM USERS MANUAL Section 6 - 20
P/N 90-00501-001



Troubleshooting & Diagnostics

Symptoms and Solutions to problems with your Industrial Printer

[ Nothing Happens when power
is turned on

 Solutic

No Power to Unit

Fuse is blown

‘Check Power cord.

Call Service Representative

Display Problem (Blank LCD Bad LCD Call Service Representative

display).

LCD display shows solid black | Bad Power Supply/ | Call Service Representative

boxes Processor board

Print Quality Problems Dried ink clogging | Clean cartridge with tissue or soft cotton

(No print) nozzles of Ink cloth and water. Purge ink cartridge.

‘ cartridge Replace ink cartridge if required.
Ink Cartridge empty | Replace ink cartridge.
Tape on Ink Remove tape from Ink Cartridge
Cartridge nozzle or
vent
Sensor blocked Clean eye of sensor with soft cotton cloth.
Bad cable or board. | Call Service Representative
Printing on belt, Correct position with ADDRESS
address location set | LAYOUT menu or set the ADJUST
off the media. PRINT menu to set the distance from the
Sensor.

Bad Encoder or Inspect the operation of the Encoder. Plug
Encoder is not the Encoder in. Verify the wheel on the
correctly installed. | Encoder turns.

Print Quality Problem Faulty or dirty Clean sensor, adjust if needed.

(blanks between printed media) | sensor
Wrong ADDRESS | Increase or decrease Lines Per Label
SETUP settings in ADDRESS SETUP to match

software.
Revision D OEM USERS MANUAL Section 7 - 1
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Troubleshooting & Diagnostics

Ink Print Quality is not sharp | Ink cartridge almost | Replace Ink Cartridge
(Gray Print) empty.
Head Print Lower Head Print Assemblies till print is

‘| Assemblies to high | clear. o

Transport Belt is Slow the Transport Belt until the LCD
moving too fast. display is at or below the 100% spd
(speed) setting or decrease the Print
Quality until the LCD spd is 100% or less.

Dried ink clogging | Clean cartridge with tissue or soft cotton
nozzles of Ink cloth and water. Purge ink cartridge.
cartridge Replace ink cartridge if required.

Ink Print Quality is not sharp Tnk cartridge almost | Replace Ink Cartridgek
(Lines through Print) empty.

Dried ink clogging | Clean cartridge with tissue or soft cotton
nozzles of Ink cloth and water. Purge ink cartridge.

cartridge Replace ink cartridge if required.

Protruding contacts | Call Service Representative

of Print Head
Holder bent
Bad Head Drive Call Service Representative
Board
Print Quality Problems ESC sequence Do a HEX Dump of the problem address.
(Unwanted Bolding) turning bold on, Examine for ESC sequence (1B) before
located before the | the start of the line. Reference printer
address. command codes to find ESC Sequence.
Remove the ESC Sequence from the
address.
Print Quality Problems Transport Belt is Slow the Transport Belt until the LCD
(Print looks stretched) moving too fast. display is at or below the 100% spd
(speed) setting or decrease the Print
Quality until the LCD spd is 100% or less.
Revision D OEM USERS MANUAL Section 7 - 2
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Troubleshooting & Diagnestics

Print Quality Problems
(Addresses "walking") to next
piece.

Incorrect address
setup

Do a hex dump, count carriage returns
(OD in hexadecimal code), and line feeds
(OA in hexadecimal code). Set Address
Setup in Setup Menu accordingly. If
address ends with a form feed (OCin
hexadecimal code), Set address setup for 8
or9.

Non Uniform print between
lines

Print head nozzles
crusted over.

Print head low on
ink.

Damaged Flex
Circuit

Clean cartridge with tissue or soft cotton
cloth and water.

Replace print head.

Call Service Representative.

Ink Streaking on media

Height adjustment
too low.

Dirty wipers.

Dirt or paper dust
on bottom of print
head.

Wiper(s) of a Head
Print Assembly
running over the
print.

Raise height of Head Print Assemblies.

Clean with tissue or soft cotton cloth and
water.

Clean cartridge with tissue or soft cotton
cloth and water.

Move the Head Print Assembly away from
where the ink is being sprayed or adjust
the wipers on the Head Print Assembly.

Print lines don't line up

Head Print
Assembly is not
level

The print cartridges
are not
synchronized

Level Head Print Assembly to be parallel
to the media.

Synchronize the print cartridges. See
section Print Adjust menu.

Revision D
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~ Troubleshooting & Diagnostics

Text is printed backwards

The printer is set to
run in the wrong

Change the DIP Switch setting

direction
‘| LED Blinking on the 3 Head =~ | Print Cartridge is | Replace the Print Cartridge and reset the
Print Holder Assembly. nearly empty. counter in the printers menu Reset Ink

The Print Cartridge is still
printing.

The Print Head Size
wasn’t set correctly.

Installed a new
Print Cartridge but
didn’t update the
Reset Ink Count in
the Main Menu.

Count.

Change the Print Head Size in the Setup
Menu. Reset the counter in the printers
Main Menu Reset Ink Count.

Reset the counter in the Reset Ink Count of
the Main Menu for the print head that has
the blinking LED.

Early feed error

Faulty or Dirty
Sensor.

Media transparent
or perforated.

Clean sensor, adjust if needed.

Choose different media. Move sensor from
problem area of media. Adjust to media.

External Font Card not
functioning

Font Card installed
incorrectly/ not
installed completely

Printer did not
register the External
Font Card.

Press font card in till firmly seated. Do not
force in or damage may occur to the
processor board. Flip card over and retry.

Turn printer off then turn printer back on
to allow printer to register External Font -
Card.

Revision D
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- Troubleshooting & Diagnestics

’Iﬁterfac":e"pr(k)ble/h\ls
(Losing characters & lines)

Bad
communications
Cable

| Bad processor

board

RS232 -C (Serial)
over maximum
length

Centronic (Parallel)
over maximum
length

Incorrect Software
Driver

Replace internal or external cable

Call Service Representative.

Replace serial cable, maximum length 15
feet

Replace parallel cable, maximum length
10 feet

Use OEM or 24K driver or dumb printer
interface (TTY, Teletype, DOS text
printer, Generic printer or use 10K, 7600,
P.B. W800 and P.B. W600.

Dropping characters, Connected
to PC, mini. Main Frames,
Wang, etc.

Protocol converter
emulating wrong
printer / incorrect
print driver
enabled.

Bad or intermittent
connection in

Use Black Box PQ-6 or PQ-7, set up to
emulate an IBM 5256 printer.

Replace printer cable.

printer cable.
Communication Overrun Bad RS232 -C Replace serial cable
(Error Message) (Serial) cable
Bad Centronic Replace parallel cable
(Parallel) cable
Computer software | Enable software XON / XOFF. Check
XON/XOFF not configuration of host computer or wiring
enabled and/ or configuration of serial cable.
DTR not enabled.
Revision D OEM USERS MANUAL Section 7 - 5
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~ Troubleshooting & Diagnostics

.

R —

Comm. Framing Error

Incorrect Baud Rate

Tum p/ri‘n’t‘er‘of’f f:hen baék onand send

(Error Message) /Word Length data again. Reset Baud rate in printer or
computer.
| Bad Centronic | Replace parallel cable.
(Parallel) cable.
Parity Error Incorrect Parity Turn printer off then back on and send
(Error Message) setting data again. Reset Parity rate in printer or

computer.

Printing wrong characters

Incorrect Software

Use OEM or 24K driver or dumb printer

Printing garbage Driver interface (TTY, Teletype, DOS text
printer, Generic printer or use 10K, 7600,
P.B. W800 and P.B. W600.
Bad processor Call Service Representative.
board
Notes:
Revision D OEM USERS MANUAL Section 7 - 6
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_ Cleaning and Maintaining the Printer

The OEM Printer is designed for trouble free service with a Preventative
minimal amount of care. Periodic cleaning of the Photo . .
Sensor, Encoder and 3 Head Print Assemblies will be Maintenance:

necessary.

CAUTION!!
CLEAN PRINT CARTRIDGE, INK SURFACES AND COVERS WITH PLAIN WATER.

ALL METAL AND PLASTIC CAN BE CLEANED WITH ISOPROPYL, DENATURED & RUBBING
ALCOHOL OR WATER ONLY.

USING ANY OTHER CLEANING SOLVENTS WILL VOID ALL WARRANTIES.
Keep cleaning solvents with petroleum based products from rubber or plastic parts.

If the print quality is unacceptable select the Purge Print Head Cleanin g

function from the Main Menu (See Section Purge Print Head). .

If problems still persist then do the following: the print
e Remove the Print Cartridge (See Section cartridges

Remove Print Cartridges). Clean the nozzles
with a soft cotton cloth. Use a dry cloth
or one moistened with alcohol to clean 0
the ink jet cartridge.
. Remove problem print cartridge and %

install a new print cartridge. %

Perform a self cleaning (Purge Print Head) cycle at the

start before printing and periodically while printing to

keep the nozzles clear of dry ink and debris.

With use, a film and/or dust builds up on the eye of the sensor Cleaning
causing misfeeds of media. Periodically wipe the outside and the Photo
eye of the sensor with a soft damp cotton cloth (WATER Sensor
ONLY).
Assembly
Eye of the Sensor Assembly.
Revision D OEM USERS MANUAL Section 8 -1
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Cleaning and Maintaining the Printer

If the wheel on the Encoder As'se¥nbly is plac.ec‘] too cl.ose to Cleaning
the path of the media where printing occurs, it is possible to
get ink transferred from the belts onto the surface of the wheel. the
Use water to dampen a soft cloth to remove the ink from the Encoder
encoder wheel.
Assembly
Clean the Encoder Wheel
The Wipers beneath the banks of Head Print Assemblies will
over time pick up ink, wax, clay and other material from the CIeaning
media it is running over. This will leave marks or smears on .
the media. Use water to dampen a soft cloth to remove the ink the Wipers
and keep the wipers clean.
Wipers
Side View Bottom View
Set for Right to Left
Revision D OEM USERS MANUAL Section 8 -2
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dn+ IAIA 2T dH HFAOW ONIILNI¥d Isal
NMOa-  3se3 ssoad 1624 umop dn TT pesH|
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dn+ L¥IA 6 dH HAOW ONIINIdd LSNray
NMOQ- 28973 ssaixd L6Z« umop dn g pesH|
dn+ LIdA 8 OH HAOW ONIINI¥d ISN0dv
NMOQ- 3se93 sssad Lézs umop dn 9 pesH]
dn+ JAIA 9 TH FAOW ONILNI¥d IsSnra
NMOQ- 23593 ssaaxd 167« umop dn g pes
dn+ LAdEA § AH HAOW ONILNIY¥d 1snrd
NMOQ- 3593 ssaxd L6z« umop dn ¢ pesH]
dan+ LIEA € OH HAOW DNILNI¥d
NMOQ- 3533 ssaad L67« umop dn
’ dn+  INEA 2 GH HAOW ONILININ
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Appendix B ¢« Hex Chart

HEX CHART
DE CIMAL 16 32 48 64 80 96
HE X 1 2 3 4 5 6 7
0 Off n~uL DLE SP 0 @ P : P
1 1ff son DC1 ! 1 A Q a
2 2]l sTX DC2 " 2 B R b r
3 3| ETX DC3 # 3 C S c s
4 4] Eor DC4 $ 4 D T d t
LSB| 5 S| Ena NAK % 5 E u e u
1 o 6] Ack SYN & 6 F Vv f v
7 71 BEL ETB ' 7 G W g w
8 8| BsS CAN ( 8 H X h X
9 9 HT EM ) 9 [ Y i y
10} Al LF SUB * J Z j z
1 B wvr ESC + : K ( K {
12 Cll Frr FS , < L \ | |
13 D cr GS - = M ) m }
14 E[| so RS ) > N A n -
15 Fll s Us / ? o) _ o DEL
HEX CHART
Example: The capital letter A is a HEX 41. Find the letter A on the above chart, and look
towards the top of the chart (MSB) and the locate the HEX number 4. Then look to
the left side of the chart (LSB) and locate the Hex number 1. Therefore the HEX
number is MSB 4 and LSB 1=41.
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Appendix C « PCL Command Codes

~Introduction

The OEM Industrial Printer emulates the listed PCL 5 printer command codes. The OEM Industrial Printer will
virtually handle media as an HP1200 would using these printer commands. Additional printer commands have
been added to allow control of special printer addressing functions and addressing needs.

The printer command codes are sets of characters that allow your computer software to override the Industrial
Printer menu selections as fonts, print quality, etc. so customized address formats can be created.

PCL Command Codes
Code Name | Symbol | HEX | DEC Description
Value | Value
Line Feed <LF> 0A 10 Causes the printer to advance the paper one line at
current line spacing.
Form Feed | <FF> 0oC 12 Causes the printer to advance the paper to the next top
of form.
| Carriage <CR> 0D 13 Causes the printer to move the current print position to
Return the left margin. Does not cause a paper advance.
Escape <> 1B 27 Indicates to the printer that the characters immediately
» following are part of a printer command.
{ Space <SP> 20 32 Causes the printer to move the current print position one
character to the right.

Note: The order that PCL Commands are received can affect the performance of the printer. PCL commands
sent in the wrong order may produce erratic and unanticipated results. The following is a quick guideline for
what order to send the PCL commands. For more explicit details see a PCL 5 Printer Language Technical
Reference Manual.

To setup a page using PCL commands the expected order is:

Reset (Esc E)
Page Orientation
Definition of a Page Size
Margins on the page
Definitions of a Font

a. Select a font

b. Set the Font Height

c. Set the Font Pitch
6. Set the positioning commands

AR S
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PCL parameterized escape sequences

____Appendix C + PCL Command Codes

(HMI)

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
Initialization
Reset <E 1B 45 027 069 Defines reset conditions
~I'Hard Reset €H 11B48 1027072 | Performs reset plus clears all |
permanent macros, fonts,
and address recovery buffer
| Page Control
Page Size Default < &I0A 1B 26 6C 30 41 027 038 108 048 065 #10 Envelope values
Page Size Executive <C&I1A 1B 26 6C 31 41 027 038 108 049 065 7.25 x 10.5 inches (18.3 x
26.7 cm)
Page Size Letter < &I12A 1B 26 6C 32 41 027 038 108 050 065 8.5 x 11 inches (21.6 x 27.9
cm)
Page Size Legal € &IBA 1B 26 6C 33 41 027 038 108 051 065 8.5 x 14 inches (21.6 x 35.6)
Page Size A4 < &I126A 1B 26 6C 32 36 027 038 108 050 054 065 210 x 297 mm
V 41
Page Size Mon Env <&I80A 1B 26 6C 38 30 027 038 108 056 048 065 7.5 x 3.88 inches (19.1 x 9.9
41 cm)
Page Size #10 Env <&I81IA 1B 26 6C 38 31 027 038 108 056 049 065 9.5 x 4.1 inches (24.1 x 10.4
41 cm)
Page Size DL Env <&I190A IB 26 6C 39 30 027 038 108 057 048 065 220 x 110 mm
41
Page Size C5 Env <&I91A 1B 26 6C 39 31 027 038 108 057 049 065 229 x 162 mm
41 '
Page Size B5 Env < &1100A 1B 26 6C 31 30 027 038 108 049 048 048 238 x 104 mm
3041 065
Page Size 9.4” x 157 | €&l1101A 1B 26 6C 31 30 027 038 108 049 048 049 9.4 x 15 inches (23.9 x 38.1
3141 065 cm)
Left Margin < &attl 1B2661#.#4C | 027038 097 #.# 076 # of Columns. Defined by
current HML
Clear Horiz Margins <9 1B 39 027 057
Top Margin & &IHE IB 26 6C #.#45 | 027038 108 #..# 069 # of Dots from origin
Page Length ©® < &I#P 1B 26 6C #.# 50 | 027 038 108 #..# 080 # of Lines
Text Length < &IH#F 1B 26 6C #.#46 | 027 038 108 #..# 070 # of Lines
Horiz Motion Index < &k#H 1B266B #.#48 | 027038 107 #.#072 # of 1/120 inch (1/47 cm)
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Appendix C ¢ PCL Command Codes

PCL parameterized escape sequences

P/N 90-00501-001

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
| Page Control
Vertical Motion Index | € &I#C 1B 26 6C #.#43 | 027 038 108 #..# 067 # of 1/48 inch (1/19 cm)
Line Spacing <&I#D 1B 26 6C #.#44 | 027 038 108 #..# 068 # of lines per inch
Page Eject < &I0H 1B 26 6C 30 48 027 038 108 048 072
Heavy Media Mode < &I6H 1B 26 6C 36 48 027 038 108 054 072 Effects feed mode selection
OFF
Heavy Media Mode < &I19H 1B 26 6C 39 48 027 038 108 057 072 Effects feed mode selection
ON
Page Orientation & &100 1B 26 6C 30 4F 027 038 108 048 079 Portrait
< &120 1B 26 6C 32 4F 027 038 108 050 079 Reverse Portrait
Dry Hold Time & &b#HT 1B 26 62 #.#54 | 027 038 098 #..# 084 Minimum time between
pieces in 1/10 seconds.
Specifies time from leading
edge to leading edge.
Dflt = 0. Max. = 300
1 Page Height <+s#H IB2B 73 #.#48 [027043 115 #.#072 # = height in PCL units.
4 (1/300 in.) (1/118 cm) Range
of values is 1050 ... 4500
(3to 15in.) (7.62 to 38.1
cm).
Page Width © &+sHW 1B2B 73 #.4#57 [ 027043 115 #..# 087 # = width in PCL units
(17300 in.) (1/118 cm) Range
of values is 1500 .. 2820 (5
t0 9.4 in.) (12.7 to 23.9 cm).
Cursor Positioning
Horizontal Position < &a#C 1B 26 61 #..#43 027 038 097 #..# 067 Move to Column no.
<Fp#X IB2A 70 #.#58 | 027042 112 #..4# 088 # of Dots
< &attH IB 2661 #.#48 | 027038 097 #..# 072 # of Decipoints (1/720 inch)
(1/283 cm)
Vertical Position < &a#R 1B 26 61 #.#52 | 027 038 097 #..# 082 Move to Row no.
A i 1B 2A 70 #.4#59 | 027 042 112 #..# 089 # of Dots
& &attV 1B 2661 #.#56 | 027 038 097 #..# 086 # of Decipoints (1/720 inch)
(1/283 cm)
Half Line Feed &= 1B 3D 027 061 Half of current VMI
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Appendix C ¢ PCL Command Codes

PCL parameterized escape sequences

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
Cursor Positioning
Line Termination € &k#HG
B 0 1 1B266B 3047 | 027038 107 048 071 | CR=CR, LF=LF, FF=FF
1 1B 26 6B 31 47 027 038 107 049 071 | CR=CR+LF, LF=LF, FF=FF
2 1B 26 6B 32 47 027 038 107 050 071 CR=CR, LF=CR+LF,
FF=CR+FF
3 1B 26 6B 33 47 027 038 107 051 071 CR=CR+LF, LF=CR+LF,
FF=CR+FF
Font Selection
(Primary)
Symbol Set <(ID 1B28#. # 027040 # .. #
<(0D 1B 28 30 44 027 040 048 068 ISO 60 Norwegian ver 1
<(01 1B 28 30 49 027 040 048 073 ISO 15 Italian
<(ON 1B 28 304E 027 040 048 078 1SO 8859
<(0S 1B 28 30 53 027 040 048 083 ISO 11 Swedish
<(0U 1B 28 30 55 027 040 048 085 ANSI ASCH
<(1D 1B 28 31 44 027 040 049 068 ISO 61 Norwegian ver 2
&(1E 1B 28 31 45 027 040 049 069 1ISO 4 UK
&<(1F 1B 28 31 46 027 040 049 070 ISO 69 French
<(1G 1B 28 3147 027 040 049 071 ISO 21 German
€28 1B 28 3253 027 040 050 083 ISO 17 Spanish
<(3S 1B 28 33 53 027 040 051 083 ISO 10 Swedish
<(4S 1B 28 34 53 027 040 052 083 ISO 16 Portuguese
<(8U 1B 28 38 55 027 040 056 085 Roman 8
<(10U 1B 28 3130 55 027 040 049 048 085 PC-8
<(12U 1B 28 31 3255 027 040 049 050 085 PC 850
(19U 1B 28 31 39 55 027 040 049 057 085 Windows 3.1 Latin
Print Quality <(s#Q
<(s0Q 1B 28 7330 51 027 040 115 048 081 Quality = Draft
<(s1Q 1B 28 7331 51 027 040 115 049 081 Quality = Letter
€(s2Q 1B 28 733251 027 040 115 050 081 Quality = Executive
<(s4Q 1B 28733451 027 040 115 052 081 Quality = Super Draft
Spacing ® &(s#P
0 1B 28 73 30 50 027 040 115 048 080 Fixed Spacing
1 1B 28 73 31 50 027 040 115 049 080 Proportional Spacing
Height <(s#V 1B 28 73 #..# 56 027 040 115 #..# 086 Point Size #/72 inch (1/28
cm)
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Appendix C « PCL Command Codes

PCL parameterized escape sequences

P/N 90-00501-001

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
Font Selection
(Primary)
| Style’ &(s#S |
0 1B 28 73 30 53 027 040 115 048 083 Upright
1 1B 28 73 31 53 027 040 115 049 083 Italic
2 1B 28733253 027 040 115 050 083 Expanded (150%)
3 1B 28 733353 027 040 115 051 083 Italic, Expanded (150%)
4 1B 28 73 34 53 027 040 115 052 083 Thin (75%)
5 1B 28 73 35 53 027 040 115 053 083 Italic, Thin (75%)
8 1B 28 73 38 53 027 040 115 056 083 Condensed (50%)
9 1B 28 73 39 53 027 040 115 057 083 Italic, Condensed (50%)
16 1B 28 73 31 36 53 | 027 040 115 049 054 083 Wide (125%)
17 1B 28 7331 37 53 | 027 040 115 049 055 083 Italic, Wide (125%)
32 1B 28 73333253 | 027 040 115 051 050 083 | Hollow
33 1B 28 73333353 | 027040 115051 051 083 Hollow, Italic
34 1B 28 73333453 | 027 040 115 051 052 083 Hollow, Expanded (150%)
35 1B 2873333553 | 027040 115051 053 083 Hollow, Italic, Expanded
(150%)
36 1B 28 73333653 | 027 040 115 051 054 083 Hollow, Thin (75%)
37 1B 28 73333753 | 027 040 115 051 055 083 Hollow, Italic, Thin (75%)
40 1B 28 7334 30 53 | 027 040 115 052 048 083 Hollow, Condensed (50%)
41 1B 2873343153 | 027040 115052 049 083 Hollow, Italic, Condensed
(50%)
48 1B 28 73 34 38 53 | 027 040 115 052 056 083 Hollow, Wide (125%)
49 1B 28 73 34 39 53 | 027 040 115 052 057 083 Hollow, Italic, Wide (125%)
Stroke Weight <(s#B
0 1B 28 73 30 42 027 040 115 048 066 Normal
3 1B 28 73 33 42 027 040 115 051 066 Bold
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Appendix C ¢« PCL Command Codes

PCL parameterized escape sequences

P/N 90-00501-001

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
Font Selection
(Primary)
Typeface T €T — — E—
3 1B 28 73 33 54 027 040 115 051 084 Courier
4 1B 28 73 34 54 027 040 115 052 084 San Serif
5 1B 28 73 35 54 027 040 115 053 084 Roman
61440 1B 28 7336 31 34 | 027 040 115 054 049 052 External (First)
34 30 54 052 048 084
61441 1B 28 73 36 31 34 | 027 040 115 054 049 052 External (Second)
34 3154 052 049 084 If available
Font Selection
Font Selection <(#X 1B 28 #..# 58 027 040 #..# 088 Font ID # from download
Font Selection
| (Secondary)
Symbol Set <)ID IB29#. # 027041 # .. #
<)0D 1B 29 30 44 027 041 048 068 ISO 60 Norwegian ver 1
<01 1B 29 30 49 027 041 048 073 ISO 15 Italian
<)ON 1B 29 30 4E 027 041 048 078 1SO 8859
<)0S 1B 293053 027 041 048 083 ISO 11 Swedish
<)OU 1B 29 30 55 027 041 048 085 ANSI ASCII
<)1D 1B 2931 44 027 041 049 068 ISO 61 Norwegian ver 2
€)IE 1B 29 31 45 027 041 049 069 I1SO 4 UK
<)IF 1B 29 31 46 027 041 049 070 1SO 69 French
)16 1B 29 31 47 027 041 049 071 ISO 21 German
€)2S 1B 29 32 53 027 041 050 083 ISO 17 Spanish
€)3S 1B 29 33 53 027 041 051 083 1SO 10 Swedish
<)4S 1B 29 34 53 027 041 052 083 ISO 16 Portuguese
<)8U 1B 29 38 55 027 041 056 085 Roman 8
<)10U 1B 29 31 3055 027 041 049 048 085 PC-38
€)12U 1B 29 313255 027 041 049 050 085 PC 850
€)19U 1B 29 3139 55 027 041 049 057 085 Windows 3.1 Latin
Print Quality <)s#HQ
<)s0Q 1B 2973 3051 027 041 115 048 081 Quality = Draft
<)s1Q 1B 29733151 027 041 115 049 081 Quality = Letter
€)s2Q 1B 29 73 32 51 027 041 115 050 081 Quality = Executive
Spacing ® <)sHP
0 1B 29 73 30 50 027 041 115 048 080 Fixed Spacing
1 1B 29 73 31 50 027 041 115 049 080 Proportional Spacing
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Appendix C « PCL Command Codes

PCL parameterized escape sequences

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
Font Selection
(Secondary)
Height <)s#HV 1B 29 73 #.# 56 027 041 115 #.# 086 Point Size #/72 inch (1/28
Style <)s#S
0 1B 2973 30 53 027 041 115 048 083 Upright
1 1B 2973 31 53 027 041 115 049 083 Italic
2 1B 29733253 027 041 115 050 083 Expanded (150%)
3 1B 29 73 33 53 027 041 115 051 083 Italic, Expanded (150%)
4 1B 2973 34 53 027 041 115 052 083 Thin (75%)
5 1B 29 73 35 53 027 041 115 053 083 Italic, Thin (75%)
8 1B 29 73 38 53 027 041 115 056 083 Condensed (50%)
9 1B 29 73 39 53 027 041 115 057 083 Italic, Condensed (50%)
16 1B 2973 313653 | 027 041 115 049 054 083 Wide (125%)
17 1B 29 73 31 3753 | 027 041 115 049 055 083 Italic, Wide (125%)
32 1B 2973 333253 | 027 041 115 051 050 083 Hollow
33 1B 2973333353 | 027041 115051 051 083 Hollow, Italic
34 1B 2973 333453 | 027 041 115 051 052 083 Hollow, Expanded (150%)
35 1B 2973333553 027041 115051 053 083 Hollow, Italic, Expanded
(150%)
36 1B 2973333653 | 027041 115051 054 083 Hollow, Thin (75%)
37 1B 2973333753 | 027041 115051 055 083 Hollow, Italic, Thin (75%)
40 1B 29 73 34 3053 | 027 041 115 052 048 083 Hollow, Condensed (50%)
41 1B 2973343153 | 027 041 115 052 049 083 Hollow, Italic, Condensed
(50%)
48 1B 29 73 34 38 53 | 027 041 115 052 056 083 Hollow, Wide (125%)
49 1B 2973343953 | 027 041 115 052 057 083 Hollow, Italic, Wide (125%)
Stroke Weight < )s#B
0 1B 29733042 027 041 115 048 066 Normal
3 1B 29 73 33 42 027041 115051 066 Bold
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_Appendix C ¢« PCL Command Codes

PCL parameterized escape sequences

P/N 90-00501-001

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
Font Selection
(Secondary)
| Typeface | €©)sHT
3 1B 29 73 33 54 027041 115051 084 Courier
4 1B 29 73 34 54 027 041 115 052 084 San Serif
5 1B 29 73 35 54 027 041 115 053 084 Roman
61440 1B 29 73 36 31 34 | 027 041 115 054 049 052 External (First)
34 30 54 052 048 084
61441 1B 2973363134 | 027 041 115 054 049 052 External (Second)
34 31 54 052 049 084 If available
Underline
Underline < &d#D
Underline On 0 1B 26 64 30 44 027 038 100 48 068
Underline On 3 1B 26 64 33 44 027 038 100 51 068
Underline Off <&d@ 1B 26 64 40 027 038 100 064
Macros @
Macro ID C&H#HY 1B 26 66 #.# 59 | 027 038 102 #..# 089 # is macro 1D
Macro Control C&H#X
0 1B 26 66 30 58 027 038 102 048 088 Start macro definition (last
ID specified)
1 1B 26 66 31 58 027 038 102 049 088 Stop macro definition
2 1B 26 66 32 58 027 038 102 050 088 Execute Macro (last ID
specified). Use current
modified print environment.
Changes retained on
completion
3 1B 26 66 33 58 027 038 102 051 088 Call Macro (last ID
specified). Use current
modified print environment.
Restore prior environment
on completion.
4 1B 26 66 34 58 027 038 102 052 088 Enable macro for auto
overlay (last ID specified)
5 1B 26 66 35 58 027 038 102 053 088 Disable auto overlay
6 1B 26 66 36 58 027 038 102 054 088 Delete all Macros
7 1B 26 66 37 58 027 038 102 055 088 Delete all temp macros
8 1B 26 66 38 58 027 038 102 056 088 Delete Macro (last ID
specified)
9 1B 26 66 39 58 027 038 102 057 088 Make macro temp (last ID
specified)
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PCL parameterized escape sequences

P/N 90-00501-001

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
10 1B 26 66 31 30 58 | 027 038 102 049 048 088 Make macro perm (last ID
specified)
Programming
1 Hex Dump Mode ON | €Y 11B 59 1 027 089 ' Data printed as hex
numbers, ESC and Control
codes not executed.
Hex Dump Mode OFF | €Z 1B 5A 027 090
Font Management
Assign Font ID # &*cHD 1B 2A 63 #.#44 | 027 042 099 #.# 068 # is Font ID
Font Control &*c#F
0 1B 2A 63 30 46 027 042 099 048 070 Delete all Fonts
1 1B 2A 63 31 46 027 042 099 049 070 Delete temp fonts
2 1B 2A 63 32 46 027 042 099 050 070 Delete last font
3 1B 2A 63 33 46 027 042 099 051 070 Delete Character
4 IB2A 633446 | 027042099 052 070 Make font temp
5 1B 2A 63 35 46 027 042 099 053 070 Make font permanent
| Soft Font Creation
L
'| Font Descriptor <)sHW IB29 73 #.#57 | 027041 115 #..# 087 data Laser Jet soft fonts are
‘ [data] data supported. These fonts
always have a 64 byte
descriptor. Desk Jet fonts
are not supported.
Character Code &eHE 1B 2A 63 #.#45 | 027 042 099 #..# 069 ASCII code no.
Download Character (sHW 1B 28 73 #..# 57 027 040 115 #..# 087 data
[data] data
Raster Graphics
Raster Graphics < *b#M
Compression
0 1B 2A 62 304D 027 042 098 048 077 Uncompressed format
2 IB2A 62324D | 027 042 098 050 077 TIFF format
3 1B 2A 62 33 4D 027 042 098 051 077 Delta Row compression
4 1IB2A 62344D | 027 042 098 052 077 Reserved
Transfer graphics | €*b#V 1B 2A 62 # 56 027 042 098 # 086 [data]
by plane [data]
Transfer Raster < FbHW IB 2A 62 #.4# 57 | 027 042 098 #..# 087 Number of bytes
Graphics data [data] [data] [data]
Raster Y Offset <*b #Y 1B 2A 62 #.# 59 | 027 042 098 #..# 089 Number of dots
[data] [data] [data]
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PCL parameterized escape sequences

Printer Feature Printer HEX DEC Equivalent Description
Command | Equivalent
Start Raster <FritA
Graphics
1B2A 723041 027 042 114 048 065 Place to left most position
1 |1B2A 723141 027042114049 065 | Place at current position
End Raster
Graphics
<*rB 1B 2A 72 42 027 042 114 066
&*rC 1B 2A 72 43 027 042 114 067 Resets left margin to 0
Set Raster <Fri#S IB2A72#.#53 (027042 114 #.# 083 Set number of pixels
Graphics Width
Set Raster <FHT 1B 2A 72 # 54 027 042 114 # 084 Height is raster rows
Graphics Height
Simple Color <*rifU : : S
Black pallet 1 1B 2A 72 3155 027 042 114 049 085 1 plane
Raster Graphics <HFHR
Resolution
75 1B2A 723735 027 042 116 055 055 082 75 dots per inch
52
150 IB2A 723135 027 042 116 049 053 048 150 dots per inch
3052 082
300 1B2A 723330 027042 116 051 048 048 300 dots per inch
30 52 082

@® The Page Width & Page Length printer commands function like the Page Size command. Using these
commands automatically enables Page Eject and disables overlay macros. Both the Page Width and Page Length
commands can be used independently and will only change the width or length to the maximum allowable page
size of 9.4 x 15 inches (23.9 x 38.1 cm). Setting the cursor positioning commands, margin settings, print data,
etc. to cause printing beyond the pages size dimensions will be cropped.

@ Only one overlay macro can be used at a time, and cannot be recursive. The overlay macros need print
quality, page parameters, etc. to determine the printers’ page setup.

® Soft font creation is in HP non compressed Bit Map Font Format.

® The resident fonts are scaleable from 8 to 30 points. If a desired font spacing does not match the font

selected an internal font will be substituted. For fixed spacing the substitute font will be Courier, and Sans Serif
for proportionally spaced fonts. Characteristics of the font being replaced, such as point size, print width, etc.,
will be matched by the substituted font.
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~ Appendix C « PCL Command Codes

To determine page size or cusor movement in Dots multiply by 300 Dots /inch (2.54 ¢cm) for Horizontal and 300
Dots /inch (2.54 cm) for Vertical. Example: a Letter size page of 8.5 x 11 inches (21.6 x 27.9 cm) is 2550 x
3300 Dots
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Appendix C « PCL Command Codes

To utilize the OEM Industrial Printers internal bar-coding features, records are searched for a valid ZIP, ZIP + 4,
Delivery Point Bar Code (DPBC) or DPBC with a check sum. For ZIP + 4 or a 11 digit DPBC, a checksum is
computed for printing a USPS Postnet bar-code with framing bars. The position of the Postnet bar-code is
determined by the printers menu setup or the bar-code location commands in effect. Bar-codes will not be
printed outside of the printers’ Page Size setup.

Printer Feature

DEC

Printer HEX Description
Command | Equivalent Equivalent
Bar Code
Non - address data <+b#A Marks data that is not part of
markers @ destination address.
1 1B 2B 62 31 41 027 043 098 49 065 marks the end of non-
address data
2 IB 2B 623241 027 043 098 50 065 marks the beginning of the
non-address data.
5 Digit Bar Codes <+b#D
0 1B 2B 62 30 44 027 043 098 048 068 Don’t print 5 Digit Bar
Codes
1 1B 2B 6231 44 027 043 098 049 068 Print all Bar Codes for zip,
zip + 4, and DPBC.
Bar Code <+b#E
0 1B 2B 62 30 45 027 043 098 048 069 Disable Bar Code
1 1B 2B 62 31 45 027 043 098 049 069 Enable Bar Code
Bar Code - Horizontal | < +b#H 1B 2B 62 #.#48 | 027 043 098 #..# 072 # of Decipoints
(1/720 inch) (1/283 cm)
Bar Code Placement <+b#P 1B 2B 62 #.# 50 | 027 043 098 #..# 080 Distance in 1/10 inch (1/4
cm) units from right edge of
media. Value of 0 indicates
edge of media
0 1B 2B 62 30 50 027 043 098 048 080 Bar Code in lower right
(default position)
1 1B 2B 62 31 50 027 043 098 049 080 Bar Code above address
2 1B 2B 62 32 50 027 043 098 050 080 Bar Code below address
@ 3 1B 2B 62 33 50 027 043 098 051 080 Print Bar Code at specified
horizontal & vertical
position, otherwise print Bar
Code in default position
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Appendix C ¢« PCL Command Codes

PCL parameterized escape sequences

Printer Feature Printer HEX DEC Description
Command | Equivalent Equivalent
Bar Code
Bar Code - Vertical <+b#V 1B 2B 62 #.#56 | 027 043 098 #..# 086 VMI # in Decipoints (1/720
inch) from bottom of page to
ZIP Code command <+b#Znnn IB 2B 62 #.#5A | 027 043 098 #..# 090 nnn #= number of characters in
Bar Code -® nnn the ZIP Code string.
n = the ASCII representation
of the ZIP code string.
<+b5Z 1B 2B 6235 5A 027 043 098 053 090 nnnnn | n = the ASCII representation
nnnnn nnnnn of the ZIP code string. Must
contain 5 digits.
<+b9Z 1B 2B 62 39 S5A 027 043 098 057 090 n = the ASCII representation
nnnnnonnn nnnnnnnnn nnnnnnnnn of the ZIP code string. Must
contain 9 digits.
<+bl11Z 1B 2B 62 31 31 027 043 098 49 49 090 n = the ASCII representation
nnnnnnnnnn | SA nnnnnnnnnnn | nnpnnnnnnnn of the ZIP code string. Must
n contain 11 digits.
<+b12Z 1B 2B 62 3132 027 043 098 049 050 090 n = the ASCII representation
nnnnnnnnnn | 5A nnnnnnnnnnnn of the ZIP code string, Must
nn nnnnnpnnannn contain 12 digits.
@ Use a pair of escape sequences, the first one before the data that is not part of the destination address

such as return addresses, graphics, messages, etc. and the other to mark the end.

Use Zip Code command when two ZIP codes are being sent. The first ZIP code will be printed without a
bar-code. The second ZIP code in the Zip Code command string will print a corresponding bar-code but
not print the ZIP code. The Zip Code command only overrides the bar-code command for the present

address.

@ Use the €+b#H and €<+b#V commands to position the bar code. Measure the position from the right-

hand corner of the leading edge of the media, not the upper left-hand corner.
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_Appendix D ¢ Character Sets

OEM CHARACTER SET
(Modeled after PC 850 Chara'cter Table) _

<SP> 0 @ P N o] G E a EE - o] (o) -
0 | 16|32 |48 |64 | 80| 96 |112|128| 144 | 160 | 176 | 192 | 208 | 224 | 240

! 1 A Q a q i ® i +
1 17 1 33 |1 49 | 65 | 81 | 97 | 113|129 | 145 | 161 241
" 2 B R b r é | £E| 6

2 18 | 34 | 50 | 66 | 82 | 98 | 114|130 | 146 | 162

r T3 trectstestrstraleoTo

242
3 19 | 35 1 51 | 67 | 83 | 99 | 115|131 | 147 | 163 | 179 | 195 | 211 | 227 | 243

$ 4 D| T ] d t F] 6 A | - | E 6 1
4 | 20 |36 | 52 | 68 | 84 | 100|116 | 132 | 148 | 164 | 180 | 196 | 212 | 228 | 244
% | 5] EJ]U]le|lulale | N|AT]TF 0| s§
5 |21 |37 | 53|69 | 8 [101]|117] 133|149 | 165|181 | 197 | 213 | 220 | 245
& | 6 | F| V| f v]alad @ | A | a 1 u
6 | 22 |3 | 54| 70| 86 102|118 | 134|150 | 166 | 182 | 198 | 214 | 230 | 246
' 7/ Gg{wW|lg|w]|c¢|u sl AJAT P |,
7 | 23| 39| 55| 71| 87 |103]|119]| 135|151 | 167 | 183 | 199 | 215 | 231 | 247
( 8 | H| X | h| x| & vl el ©] & 1 p °
8 | 24 | 40 | 56 | 72 | 88 | 104 | 120 | 136 | 152 | 168 | 184 | 200 | 216 | 232 | 248
ylo 1y [ifJylel[o]@® T r [ [0]
9 | 25|41 |57 | 73|89 |105| 121|137 | 153 | 169 | 185 | 201 | 217 | 233 | 249
<LF> * : J [z j z | e | U ] = rl U] .
10 | 26 | 42 | 58 | 74 | 90 | 106 | 122 | 138 | 154 | 170 | 186 | 202 | 218 | 234 | 250
<ESC>1 4 ; K [ k { i g | 2| 3 T u
1M | 5, | 43|59 | 75 | 91 [ 107|123 | 139 | 155 | 171 | 187 | 203 | 219 | 235 | 251
<FF> , < L \ 1 ] i £ 4 F | om
12 1 28 | 44 | 60 | 76 | 92 | 108 | 124 | 140 | 156 | 172 | 188 | 204 | 220 | 236 | 252
<CR> - - M ] m } i %] i ¢ o l
13 129 |45 | 61| 77 | 93 | 109|125 141 | 157 | 173 | 189 | 205 | 221 | 237 | 253
. > N A n ~ A « ¥ I 1 -
14 | 30 | 46 | 62 | 78 | 94 | 110|126 | 142 | 158 | 174 | 190 | 206 | 222 | 238 | 254
I T 2]lof _1o AT fFl» 1= | ®] |™

15 | 31 | 47 | 63 | 79 { 95 | 111 | 127 | 143 | 159 | 175 | 191 | 207 | 223 | 239 | 255

International Character Substitution
The following industry standard character substitution techniques are utilized:

ISO |Character ID |35 1|36 |64 |91 [92 |93 |94 196 |123 |124 |125 [126
# |Set Name # ~

6 ANSI ASCII oU # IS 1e |l N 1 In { | } ~
69 |French 1F 12 8 1a [° lc I8 |1 |lu lée Ju e I
21 German 1G |# 1% |I§ [A IO JU I~ ' |a |6 U B
4 United Kingdom [1E |£ |$ (@ ][ [N I | { | } -
60 |Norwegian/Danish |[0OD {# [$ |@ (£ |0 |[A |» e o & [
11 |Swedish/Finnish [0S [# o |[E JA [O A JU [é Ja o [a Tlu
15  |ltalian o (£ I1$ 18 I° e e ™ [u ]a 0 € i
17 |Spanish 28 1£ $ 18§ i IN s I T f° i _lc |~
61 [Norwegian/Danish 1D [§ 1$ e |&£ | |A |» 2 lo la |
16 |Portuguese 4S (# 1$ 1§ |A |IC O |n a e o J°
10 |Swedish 38 |# [o [@ |A O A |~ a (6 & |
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Appendix D ¢ Character Sets

OEM CHARACTER SET
(Modeled after 8859 Latin Character Table)

s 0 @ | P | p T A|lDP]al e

0 |16 |32 | 48 | 64 | 80 | 96 | 112|128 | 144 | 160 | 176 | 192 | 208 | 224 | 240

1 1 | A Q| a ] q i + | A| N]| & | n

1 117 | 33| 40 | 65 | 81 | 97 | 113|129 | 145 | 161 | 177 | 193 | 209 | 225 | 241

"2 [ BR[| b ][ ¢ AlOoO|aloe

2.1 18 | 34|50 | 66 | 82| 98 |114] 130|146 162|178 | 194 | 210 | 226 | 242

# | 3| C| S| c | s £ Al O] aloe

3 |19 |35 |51 |67 83| 99 |115| 131|147 | 163|179 | 195 | 211 | 227 | 243

$ | 4| D[ T | d ]|t X “"TA|T O] a| e

4 | 20 | 36 | 52|68 | 84 | 100|116 | 132|148 | 164 | 180 | 196 | 212 | 228 | 244

% | 5| E|]U|[ e | u ¥ | w|A]O] & ]| o

5 | 21|37 | 53|69 | 85 |101]| 117|133 | 149|165 | 181 | 197 | 213 | 229 | 245

& | 6 | FlV f v ! 1/ &£ 0| =] 6

6 | 22| 38| 54|70 | 8 | 102|118 134|150 | 166 | 182 | 198 | 214 | 230 | 246
' 711G (W|]g|w § | € ¢

7 | 23| 39|55 | 71| 87 |103]|119] 135|151 | 167 | 183 | 199 | 215 | 231 | 247

(s H] X h] x - . E|Oo| & | o

8 | 24|40 | 56| 72| 88 | 104|120 | 136 | 152 | 168 | 184 | 200 | 216 | 232 | 248

) 9 1| Y | i y © E| U] & | u

9 | 25| a1 |57 | 73| 89 |105] 121|137 | 153 | 169 | 185 | 201 | 217 | 233 | 249

<LF> * s Jd [z z a E| U] e | u

10 | 26 | 42 | 58 | 74 | 90 | 106 | 122 | 138 | 154 | 170 | 186 | 202 | 218 | 234 | 250

<ESC>[ ; K [ k { « » E U é 1]

1M | 5, | 43|59 | 75 | 91 | 107 [ 123 | 139 | 155 | 171 | 187 | 203 | 219 | 235 | 251

<FF> , < L \ ' ’ ' U i U

12 1 28 | 44 | 60 | 76 | 92 | 108 | 124 | 140 | 156 | 172 | 188 | 204 | 220 | 236 | 252
T Tl = m 1 [ m]3 - T w [0 i

1312045 | 61| 77| 93 |109] 125|141 | 157 | 173 | 189 | 205 | 221 | 237 | 253

] S | N[~ | n | ~ ® TP | 1 b

14 | 30 | 46 | 62 | 78 | 94 | 110 | 126 | 142 | 158 | 174 | 190 | 206 | 222 | 238 | 254

;7 1210l _ 1o - i i B | i 7

15131 | 47|63 | 79| 95 | 111|127 | 143|159 | 175 | 191 | 207 | 223 | 239 | 255

The ID# for the ISO 8859 Character Set is (ON).
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~ Appendix D « Character Sets

OEM CHARACTER SET
(Modeled after Roman -8 Character Table)

s> o0 e | P p - a | AlAT]DP

0 |16 | 32 | 48 | 64 | 80 | 96 | 112|128 | 144 | 160 | 176 | 192 | 208 | 224 | 240

! 1Al Q| a]gq A ) i AlpPp

1 |17 | 33| 49 | 65 | 81 | 97 | 113|129 | 145 | 161 | 177 | 193 | 209 | 225 | 241

“1T 2| B[R] b | r A 6 | @ | a |-

2 |18 [ 34| 50 | 66 | 82 | 98 | 114 | 130 | 146 | 162 | 178 | 194 | 210 | 226 | 242

# 13| C|s]|e¢ s E ° a | E| D | p

3 119 |35 | 51|67 | 83|99 |115|131|147 163|179 | 195 | 211 | 227 | 243

$ | 4 | D[ T | d| t E|[C|alal|eolT

4 | 20 | 36 | 52|68 | 84 |100]| 116|132 | 148 | 164 | 180 | 196 | 212 | 228 | 244
% | 5| E|] U] el u E| ¢ | é i i

5 | 21|37 | 53|69 | 85 |101]|117 133|149 | 165 | 181 | 197 | 213 | 229 | 245

& | 6 | F | V] F ]| v i N| 6| o i -

6 | 22 | 38| 54|70 | 8 |[102]118| 134|150 | 166 | 182 | 198 | 214 | 230 | 246
! 7 G | W g w I n a F= ] o

7 | 23|13 | 55|71 |87 |103]119]135]| 151|167 | 183|199 | 215 | 231 | 247

( 8 | H| X h X : i al Al O] %

8 | 24 | 40| 56 | 72|88 |104| 120|136 | 152|168 | 184 | 200 | 216 | 232 | 248

) | 9 | 1 | Y i y . | e i | O | °

9 | 25|41 |57 | 73| 89 |105]| 121|137 | 153|169 | 185 | 201 | 217 | 233 | 249

$F> * . J 7z j z A X o O o °

10 1 26 | 42 | 58 | 74 | 90 | 106 | 122 | 138 | 154 | 170 | 186 | 202 | 218 | 234 | 250

<ESC>| 4 ; K [ k { - £ u U S «

11| 57 | 43|59 | 75 | 91 [ 107|123 139 | 155 | 171 | 187 | 203 | 219 | 235 | 251
<FF> | < L |\ 1 I ¥ | a| E | &

12 1 28 | 44 | 60 | 76 | 92 | 108 | 124 | 140 | 156 | 172 | 188 | 204 | 220 | 236 | 252

<CR> - - M ] m } U § e i U »

1831 20|45 | 61| 77| 93 |100] 125|141 [ 157 | 173 | 189 | 205 | 221 | 237 | 253

. > | N A n ~ vl s 6 B Y +

14 | 30 | 46 | 62 | 78 | 94 | 110 | 126 | 142 | 158 | 174 | 190 | 206 | 222 | 238 | 254
I T21lo0o] _ 1o el ¢ a0y

15 | 81 | 47 | 63 | 79 | 95 | 111|127 | 143 | 159 | 175 | 191 | 207 | 223 | 239 | 255

The ID# for the Roman 8 Character Set is (8U).
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Appendix D ¢ Character Sets

OEM CHARACTER SET
(Modeled after Windows 3.1 Latin Character Table)

s>1"0 @ | P | ° P T A|D| a] o

0 | 16|32 | 48 | 64|80 | 96 | 112|128 | 144 | 160 | 176 | 192 | 208 | 224 | 240

' |1 | A|lQ] alq Tl = | A|N]| a]|n

1 117 | 33| 49 | 65 | 81 | 97 | 113|129 | 145 | 161 | 177 | 193 | 209 | 225 | 241

"2 | B|R| b | r . ¢ AlO]| a]o

) 2 118l 345066 8298|114 130 146] 162] 1781 194 | 210 | 226 | 242

# | 3] c|S|c]|s|f “« 1 g AloO]|a]ée

3 |19 |35 |51 |67 |83 99 |115]| 131|147 | 163|179 | 195 | 211 | 227 | 243

$ | 4 | D| T | d| t | & RNYEEERE

4 | 20| 36| 52| 68| 84 |100]| 116|132 | 148 | 164 | 180 | 196 | 212 | 228 | 244

% | 5 E | U e u . ¥ pw| Al O | a 6

5 [ 21 | 37 | 53 | 69 | 85 | 101 | 117 | 133 | 149 | 165 | 181 | 197 | 213 | 229 | 245

& | 6 | F V]| f | v [ T T 9T E]O0|==]|o

6 | 22| 38| 54| 70| 86 | 102|118 | 134 | 150 | 166 | 182 | 198 | 214 | 230 | 246
' 711G |W|g|w — | § . G ¢

7 | 23| 39|55 | 71|87 |103]| 119|135 | 151 | 167 | 183 | 199 | 215 | 231 | 247

(I8 H| X ]| h | x|~ - | El @ e | o

8 | 24|40 | 56 | 72 | 88 | 104|120 | 136 | 1562 | 168 | 184 | 200 | 216 | 232 | 248

) | 9 | 1 | Y | i y ™ [ © E|U| é | u

9 | 25 | 41 | 57| 73| 89 | 105|121 | 137 | 153 | 169 | 185 | 201 | 217 | 233 | 249

<LF> * : | Jd |z |z ]|S]s]|° E| U | e | a

10 | 26 | 42 | 58 | 74 | 90 | 106 | 122 | 138 | 154 | 170 | 186 | 202 | 218 | 234 | 250

<ESC>| 4 ; K [ k { « » E u é a

11| o, | 43 | 59 | 75 | 91 | 107 | 123 | 139 | 156 | 171 | 187 | 203 | 219 | 235 | 251

<FF> S| < | L |\ 1 I T Ul 1] @

12 | 28 | 44 | 60 | 76 | 92 | 108 | 124 | 140 | 156 | 172 | 188 | 204 | 220 | 236 | 252
<CR> - = M ] m } - Yo | i

13 1 29 |45 | 61| 77 | 93 | 109|125 | 141 | 157 | 173 | 189 | 205 | 221 | 237 | 253

.| > I N| ~ | n |-~ ® T | p | 1| p

14 | 30 | 46 | 62 | 78 | 94 | 110 | 126 | 142 | 158 | 174 | 190 | 206 | 222 | 238 | 254

/ 210] _| o Y | - é ] Bl i |y

15 | 31 | 47 | 63 | 70 | 95 | 111|127 | 143 | 159 | 175 | 191 | 207 | 223 | 239 | 255

The ID# for the Windows 3.1 Latin Character Set is (19U).
The Windows 3.1 Latin symbol set is recommended to use when running Microsoft Windows 3.1 / Windows 95.
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~___Appendix D o Character Sets

OEM CHARACTER SET
(Modeled after PC - 8 Character Table)

<sP> | 0 @ P Ny P C E a L .
0 | 16|32 |48 |64 |80 |96 |112]128] 144160 192 | 208 | 224 | 240
! 1 A Q a q i ® i
1 17 | 33 | 49 | 65 | 81 97 | 113 | 129 | 145 | 161
" 2 B R b r é E [ T
2 18.1 .34 | .50.}.66-1 .82 1 98 1 1141 130} 146.} 162 1 178 | 194 | 210.| 226 | 242 }
# 3| C|S|c s aj| o u |
3 19 | 35 | 51 67 | 83 | 99 [ 115] 131 | 147 | 163 | 179 | 195 | 211 | 227 | 243

$ 4 D T d t a o ] -
4 | 20 | 36 | 52 | 68 | 84 | 100|116 | 132 | 148 | 164 | 180 | 196 | 212 | 228 | 244

% 5 E U e u a ) N
5 21 { 37 | 53 | 69 | 85 | 101} 117 | 133|149 | 165 | 181 | 197 | 213 | 229 | 245

& | 6 FlV f v a ] @ 1]
6 1 22|38 | 54|70 | 8 |102|118] 134|150 | 166 | 182 | 198 | 214 | 230 | 246
! 7 G w g w [ u °
7 1 23| 39|55 | 71|87 |103|119]135| 151 | 167 | 183 | 199 | 215 | 231 | 247

193 | 209 | 225 | 241

( 8 | H| X | h| x| e ]|y | ¢ & °
8 | 24 | 40 | 56 | 72 | 88 | 104 | 120 | 136 | 152 | 168 | 184 | 200 | 216 | 232 | 248
) 9 1 Y i y é | O 1 Pl .
9 | 25 | 41 |57 | 73|89 |105| 121|137 | 153 | 169 | 185 | 201 | 217 | 233 | 249
— <LF> 1T Tolz|ilz]e]0 T r .
10 | 26 | 42 | 58 | 74 | 90 | 106 | 122 | 138 | 154 | 170 | 186 | 202 | 218 | 234 | 250
FCl e s KD kT ¢ % |F
M | 5; | 43| 59 | 75 | 91 [107 | 123 | 139 | 155 | 171 | 187 | 203 | 219 | 235 | 251
<FF> , <L v ' |7 ¢ I F | m
121 28 | 44 | 60 | 76 | 92 | 108 | 124 | 140 | 156 | 172 | 188 | 204 | 220 | 236 | 252
<CR> - = | M| ] |m]} i ¥ i =
13129 | 45 | 61 | 77 | 93 | 109 | 125 | 141 | 157 | 173 | 189 | 205 | 221 | 237 | 253
. > N A n ~ A « I
14 | 30 | 46 | 62 | 78 | 94 | 110 | 126 | 142 | 158 | 174 | 190 | 206 | 222 | 238 | 254
/ ? o - o A f » 1 L

151 31 | 47 | 63 | 79 | 95 | 111|127 | 143 | 159 | 175 | 191 | 207 | 223 | 239 | 255

The ID# for the PC 8 Character Set is (10U).
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_ Appendix E ¢ Accessory Cable & Computer Interface Wiring Diagram

The parallel interface port is a standard 36 pin Amphenol type

with two metal wire retaining clips. Parallel
Pin # Signal Direction Description Communication
1 Strobe In A Low pulse causes the printer (Centronics
to read one byte of data
29 | Data0-Data7 | In Data lines. Data 0 is the LSB Cable)
10 Acknowledge | Out The printer sends a low pulse to
- indicate that it has aceepted a
byte of data and is ready for
more.
11 Busy Out The printer sends a High to
indicate that it cannot receive
data to data entry, a full buffer.
12 Paper Error Out The printer sends a High logic
level to indicate to the computer
that it is out of paper.
13 On Line Out The printer sends a High logic
level to indicate to the computer
that it is in an On Line status.
16 Sig Gnd These pins are tied to signal
ground
17 Chassis Gnd Chassis Ground
18 HI Out The printer outputs a High logic
level (+5V through a 2.2K ohm
resister) on this pin while it is
turned on.
19-30 | Sig Gnd In Signal Interface Ground
31 Reset /Input The printer may not work when
Prime this line is low.
32 Error Out The printer sends a Low logic
level to the printer to indicate
that it is in an error state.
. Achunég ‘ Dota 7
“R5 e I e ¢
. A
Choség gm% Be 1S 5
HI e
|
I
&"’?“‘i AR R R AR
Error ' Sig Gnd
Reset
Sig GND |
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___Appendix E ¢ Accessory Cable & Computer Interface Wiring Diagram

The Accessory Port allows the printer to work in conjunction
with a Diverter Arm, a Feeding Device and a variable Speed
Conveyor. Use the Accessory Port to connect the printer to

either one or all of these devices.

To connect and operate the Diverter Arm signal see

Diverter Control section in the Setup menu.

~To connect and operate the Conveyor Speedup signal
see the Conveyor Distance menu in the Postal Bundle

Brk (Break) menu.

The feeder portion of the port will stop the feeder when

Accessory Port:

the printer has received the last piece to print. Use the Feeder

Signal to stop the feeder from sending
blank pieces after the printer has finished

printing.

The printer will send a 40 millisecond
~ pulse signal to stop the feeder only if:

1) The printer is On-Line.

2) The last record has been received and
no new data is coming or being

received.

Feeder Sigral -

Conveyer Speedup *@ ~

Divert -

3) The last piece to print has passed the Sensor Assembly.

Use the Cable Assembly Schematic to set up a 5 volt DC relay
for Pin 1 and Pin 2 and a relay for Pin 1 and Pin 6.

Note: Place the Ssor Assembly

close to the Feeder Assembly t
the number of blank pieces tht
onto the transport due to inert

DB25 _ . DB9 .
CHSGND [ 1 p-Shield Serial
&g 2 2 $XD
3 3 XD = =
E 5 : bTR Communication
DTR 20 ' 8| CTs (RS - 232 C)
SIGGND |7 5 | SIGGND .
connections for
PRINTER COMPUTER the Industﬂal
Printer
DB25 DB25
CHSGND [ 1 1 | CHS GND
TXD 2 3 RXD
RXD 3 2 TXD
CTS 5 I 20| DTR
DSR 6 SIG GND
SIGGND [ 7 [ 5 CTS
DTR 20 6 DSR
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_Appendix F ¢ Printing with Software

Software Table of Contents

P/N 90-00501-001

MICROSOFT WINDOWS™ APPLICATIONS SOFTWARE DRIVER INFORMATION .........cccevenrerenen... 3
Software Interface sample: AccuZIP 6 for Windows 4
Software interface sample: ARCLIST ver. 2.06 6

* Software Interface sainple: Bulk Mailer + 4.20i for Windows.......... 7
Software interface sample: DATAPERFECT ver 2.2 9
Software Interface sample: dBASE IV ver 1.0 10
Software interface sample: FILE EXPRESS ver. 5.1 11
Software interface sample: IBM FILING ASSISTANT 13
Software Interface sample: Microsoft FoxPro 2.6 for Windows 14
Software interface sample: LOTUS 123 Release 3.1+ for DOS 20

- Software interface sample: MailMiser ver 1.2 21
Software interface sample: MULTIMATE 22
Software interface sample: MyMailList ver. 1.9.7 23
Software Interface sample:  Postalsoft Desktop Mailer ver. 5.0 for Windows.........c.ccue... 24
Software Interface sample:  PreSort Pro by MCS version 2.4 for Windows..........ceceeveven.e 26
Software interface sample: RAPIDFILE 28
Software interface sample: REFLEX ver. 2.0 .29
Software interface sample: WORDPERFECT 6.0 30
Software interface sample: WORDSTAR FOR DOS ver. 7.0 31
POWER PRINT for the MACINTOSH 32
POWER PRINT for the MACINTOSH (Continued) 33
Computer setup sample: IBM Mini's (System 34, 36, 38) & AS400 34
Software interface sample: MICROSOFT WORD FOR WINDOWS ver. 2.0........ccceuu.. 35
Software interface sample: Word97 for Windows 95 36
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- Appendix F ¢ Printing with Software

Software Setup

This section will help in setting up the Address Printer to run programs in Windows 3.1 and
DOS. Some assistance is given for use on the Apple and Macintosh. If you are using Windows
95/ 98 or Window NT 4.0 use the OEM driver installation disk that is included in the
accessories kit.

Generic Software Driver Information

Most software packages allow you to select or setup a printer driver. Use one of the
following printer drivers.

Dumb Printer

Generic Printer

Typewriter

Plain Vanilla

Teletype

TTYCRLF Printer

TTYCR Printer (This requires the Setup Menu CR = CR + LF option to be

turned on)

If none of these choices are available one of the following may work:

HP Laserjet Series Il or any Laserjet II listed (excluding Postscript)
HP Laserjet 4
DOS Text Printer

Don't forget to set the MODE COMMAND!!!

Type the MODE command at the DOS prompt or add the MODE command to the
AUTOEXEC.BAT file. The AUTOEXEC.BAT will load the command when the
computer is first booted up.

Example:
When printing to the parallel port load MODE LPT1:,,P
When printing to the serial port load MODE COM1:9600,N,8,1,P

(NOTE: The printer ports or parameter settings may vary from the preceding
MODE command examples. If using DOS version 5.0, a ,,B may be substituted for
the ,,P)
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Appendix F ¢ Printing with Software

MICROSOFT WINDOWS™ Applications Software Driver Information

Microsoft Windows Software Driver Information

When using Microsoft Windows 3.0 or later, select the Generic / Text printer driver.

Microsoft Windows95/98 Software Driver Information

Changing the Print Driver Properties might have to be made for the printer to work
with different software packages in the Windows95/98 operating environment.

I. Click START ... SETTINGS... PRINTERS BOS 24K Properties

2. Highlight the printer driver being used (usually
9K-L /24K / OEM)

3. Click FILE ... PROPERTIES
4. Click on the DETAILS tab

5. Click on PORT SETTING ... make sure that
) none of the boxes are checked. Click on OK

6. Click on SPOOL SETTING... check the box for
“Print directly to printer”.

7. Check the box for “Disable bi-directional
support for this printer”. Click on OK.

8. Check the GRAPHICS tab when pictures are
missing or printed out incorrectly. Note: Some software may require chcklng on an
OPTIONS button to open a dialog box of check BOS 24K Properties '
boxes options.

9. Click on APPLY once settings are correct.

Updating the Printer Software

Periodically updates of printer drivers are made
available on the World Wide Web. To obtain updates
go to http://www.BryceUSA.com.
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Appendix F ¢ Printing with Software

Software Interface sample: AccuZIP 6 for Windows

Installation:
Follow the instructions in the User Manual to install Accuzip 6.

Choose Print Setup from the File Menu.

The Print Setup
window will be
displayed.
Select the
Generic/Text
Only printer.

Click on OK

Choose Print from
the File Menu, then
select Labels.

The Print Labels
window will be
displayed.

Select the desired

option

Click on Continue.
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Appendix F ¢ Printing with Software

The Print window will be displayed. Select Label Format.
Ensure that there is not a check in the Print Barcode box.
Select the BRYCE.LBX label template.

Select Continue.

You are currently on record 2

£ Directimprint [ Print Barcode

€ Disk File

Pause Pringing

Another Print window will be displayed.

Ensure that the Generic/Text Only is the selected printer.

Choose the desired Print range.

NOTE:

1. Set the address setup option, in the Bryce setup menu, to 8 lines.

1. Ignore the print quality selection that is dlsplayed in the Print quahty section of the Print
window. The print quality you
desire can be set in the Bryce
Main Menu under the Print
Quality option.

Select OK to print to your Bryce
Address printer.
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Software interface sample: ARCLIST ver. 2.06

The Arclist program must be configured for use by the Bryce BOS OEM in terms of both printer type selection and
output type selection.

You must first identify the Bryce BOS OEM printer
o Run Arclist program called CONFIG. - e ‘
Choose PRINTER from menu, then choose CUSTOM from menu, then type Bryce BOS OEM as printer.
When this information is entered, a PORT menu will be displayed.
Select appropriate port, and characteristics if using a serial port.
NOTE: The BOS OEM must have the same port characteristics as the computer port.
All special entries (line feed, fonts, etc.) should be left blank.
Select SAVE from menu, then choose OKAY from menu.
Select QUIT from menu, then choose SAVE from menu.

Next identify the address format.
Run ARCLIST.
Select LABELS from menu, then choose PRINT from menu, use the arrow keys to select a format.
Select Bryce BOS OEM .
Enter data according to the table below.

Title: Bryce BOS OEM
Label Type: envelope
Pitch: pica

Font: Normal

Line Feed: Normal

Left Margin: 0

Label width in chars: 42
Lines per label: 8

Top Margin: 0

Labels Down: N/A

Lines Between Labels: N/A
Labels Across: N/A

Space Between Labels: N/A

Criteria: All

Index: Record

Order: Ascending
Printer: Bryce BOS 10K

Select ALL or Nth
Select INDEX or PRESORT
Select DEFAULT from Printer Menu
Select NON-STOP or PAUSE
Select GO from Printer menu
Print Mailing Labels
NOTE: To pause program while printing, press ESC on Computer Keyboard instead of turning off the

On-Line light on the BOS OEM.
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Appendix F ¢ Printing with Software

Software Interface sample: Bulk Mailer + 4.20i for Windows

Installation:

Follow the instructions in the User Manual to install Bulk Mailer.

Select New from the File Menu.
- Follow the instructions in the Users Manual on how to enter your address information.
When you are ready to print addresses;

Select Direct Format from the Report Menu.

Select Edit Report from the Format Menu.
Move the fields to the upper left corner of the mail piece, as shown below.

Select Preview Report from the Format Menu.
- Bulk Mailert - Direct Format Ed [
le Edit Eptry Search Sert Format Report Window Help

D]=]e] 2@ =]X] ) BEE

Direct Format

First Name ;Léét ame |

Country:

Phone: Car-Rt: I I
Title:
Search Codes: ! XCode: f [ Date: I
Comments:

For Help, press F1 = [NOMT

Select Print Setup from the File Menu.
Select the Generic / Text Only printer driver, as shown below.

Click on OK.
" Print Setup
Géneric 7 Test Only on LPT1:
loter0172xT1m [
continued on next page
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Appendix F ¢ Printing with Software

Select Print Direct from the File Menu.
Select the Bryce printer from the Print Direct Window (shown below).

Print Direct

Cancel

Set the ADDRESS SETUP, located in the Bryce printers Setup Menu, to 8 lines.

You are now ready to print.
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Appendix F ¢ Printing with Software

Software interface sample: DATAPERFECT ver 2.2

Refer to the DataPerfect Reference Manual to setup a database for printing labels.

While using DataPerfect, a label must be defined in order to print your addresses on the BOS
OEM.

~ Be sure the cursor is in the panel from which you want to run the report.

Press Report/Export (Shift-F7) to access the report list.

With the cursor on Built-In Short Reports, press Insert to create a new report.

Select Edit Report Name (9), then enter the desired report name (for example, BOS OEM C

Label). If you want to send report to the BOS OEM, select Printer On/Off (1), then type in the
appropriate port number.

Select Print Margins (7), then enter the following data:

Top

Bottom

Left

Text Lines
Select Edit Report Form (8).

No oo

Move the cursor to the Report Body section of the report form, then press Report Options
(Ctrl-F7).

Select Labels (5).

Enter 1 as the number of labels across the page.

Enter 45 as the width in characters of each label.

Enter 7 as the number of lines per label.

The code for the label specifications is displayed in the Report Body section.

Use Select (F4) to select the fields needed for the labels. Be sure that the alphanumeric fields are
edited to include the ::T print mode indicator. (See Field Format, Print Mode Indicators in your
Reference Manual).

Press Exit (I'7) or Save (F10) to save the report form when you have completed selecting fields.
You will return to the Report Menu.

Set the ADDRESS SETUP in the BOS OEM SETUP MENU to 7 lines.
You are now ready to print addresses on your BOS OEM.
Press Report/Export (Shift-F7) to run the report.
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Appendix F ¢ Printing with Software

Software Interface sample: dBASE IV ver 1.0

Upon entering dBASE, the dBASE Control Panel will be displayed.

To Create a Label, move cursor to the labels column and select <create>.

A label will be displayed on the screen.

Press ALT & D, to pull down the Dimensions menu, the following settings should be entered;

_Widthoflabel 45

Height of label Set to the number of lines in your address
Indentation 0
Lines between labels 1
Space between columns 1
Columns of labels 1

Press ESC
Add fields to label using the instructions at the bottom of the screen.
Once you have completed your layout, press ALT & L to pull down the Layout menu and
select;
Save this label design.
When this label format is saved, it will be displayed as a file under the labels column in the
control panel.
To Print labels;
Activate a data file;
Select the label file you created under the labels column;
Follow menu directions to print.

NOTE: dBase IV does a CR & LF before each address, therefore you must do the
following:
IF SEVEN LINE ADDRESS, DO A FF BEFORE THE START OF THE NAME,
Example <CR> <LF>
CHR(12)+NAME
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Software interface sample: FILE EXPRESS ver. 5.1

When using FILE EXPRESS, A label must be defined in order to print your addresses on the
BOS OEM.

Select Label Printing (6) from the Main Menu.
Select Design a New Label from Label Menu.

- Enter Data into the Label Spacing Screen according to the following table:

1 How many labels across the page (1-5) 1

2 Spaces across from label to label (10-500) n/a
3 Lines down from label to label (1-999) 7

4 Printable lines on each label (1-250) 7

5 Characters per line on each label (10-999) 45
6 Tab position to first label (1-99) 1

When you have completed entering this data, press F10 to accept these changes.
A Test Printer Screen will be displayed, if you would like to test this setup press Y, if not press
N ; ,

File Express will display a label box on the screen the size that was specified on the Label
Spacing Screen.

Type ALT-F to pop up field window.

Move highlight bar to the field you would like on the first line of your label.
Press Enter twice, to accept it as a field only.

Repeat the above sequence to place your fields in the appropriate locations.
When you are finished designing your label, press F10.

The Record Selection Screen will be displayed. Press Enter.

The Label Sub Menu will be displayed.
Select S (to select save option).

Press Enter (to confirm you want to save).
Type in a name for your label.

Press Enter.

Type a description for you label.

Press Enter (to save your label layout)

While you are in the Label Sub Menu, now would be a good time to specify a printer.
Press 7 to update printer options.
Press Enter
Press ALT-S to select a printer definition file.
Select POSTSCRIPT - Generic., and press Enter.

CONTINUED ON NEXT PAGE
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Appendix F ¢ Printing with Software

FILE EXPRESS ver 5.1 continued

The Printer Option Menu will be displayed, enter the following data:

1 | Printer Definition File PostScript
2 | Printer Port <1>, <2>, <3>, or <D>efault (LPT1) Enter the appropriate port #
3 | Line Spacing 6
A Pt [Riorreaia
5 | Printer Initialization String D for Default
6 | Printer Reset String D for Default
Press F10
Select Record#
Select Yes

Set the Address Setup Menu on the BOS OEM to 7 lines.

You are now ready to print addresses on your BOS OEM printer.
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Software interface sample: IBM FILING ASSISTANT

Refer to the IBM Filing Assistant manual to setup a database for printing labels. The program

uses pre-set printer specifications which are defined.
From the main menu choose PRINT
From the print menu choose PREDEFINED PRINT SPEC.
Create a new print spec called BRYCE
Set up the format for the output of the address as follows, or alter it to better suit your database.

(A proper address format, as per USPS guidelines, is listed in Appendix H). The X and the +
symbols are an important part of the print specifications.

Name: X

Title: X

Company: X

Address: X

City: + State: + Zip: +

Using the Bryce print spec, the program should now be able to output your address list to the
Bryce Machine.
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Software Interface sample: Microsoft FoxPro 2.6 for Windows

Installation:
Follow the instructions in the User Manual to install Microsoft FoxPro.

Choose Label from the Catalog Manager, then click on New.
: i Microsoft FoxPro
File Edit View Data Tools Window Help

FoxPro Catalog Manager ]W [Hum |

The Create Label window will be displayed. Select the table or query you wish to create a label
for.
Click on Label Wizard
= : : Microsoft FoxProi
File Edit View Data Tools Window Help
Create Label
[T T T
continued on next page
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~ Appendix F ¢ Printing with Software

The Label Wizard - Step 2 of 5 window will be displayed.
Select Avery #5165 (82x 11)
Click on Next

Microsoft FoxPro
Edit View Data Tools Window Help

3-1/3"
8-1/2" -

Misrasolt FoxPro Wizards [Tins TRom [
The Label Wizard - Step 3 of 5 window will be displayed. Select the fields you wish to include
in your label.
Insert a space between the City and State fields, and also between the State and Zip fields, as
shown below.
When you have done this, Click on Next.

. L 5 Microsoft FoxPro
File Edit View Data Jools Window Help

Label Wizard - Step 3.0f5

Cig-State Zip

=

Micrasoft FoxPro Wizards I [ins [Num [
continued on next page
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The Label Wizard - Step 4 of 5 window will be displayed. Select the field or fields you wish to
sort by.

Note: If Descending is selected, the mail pieces will be stacked in ascending order when they
exit the Bryce printer.

Click on Next

: Microsoft FoxPro
File Edit View Data Tools Window Help

Miciosoft FouPro Wizards l [ine [Hum [
The Label Wizard - Step S of 5 window will be displayed.
Select Save Label for Later Use.
Select Finish

The Save As window will be displayed.

Enter a filename for the label file. In our example, we have selected the filename
BOS_TEST.Ibx.

Select OK.

This will bring you back to the Catalog Manager. Select the file Bos_test.
Click on Modify. (see next page)

continued on next page
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» i Microsoft FoxPro
File Edit View Data Tools Window Help
Catalog Manager~ Sample
FoxFio Catalog Manager ( [ns [Hum I
The Change Label window will be displayed.
Click on Label Writer.
: Microsoft FoxPro -
File Edit View Data Tools Window Help
)
FoxPro Catalog Manager I Mrs [Hum |
p continued on next page
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The Microsoft FoxPro Label Edit window will be displayed.

No fields will appear on the display, this is because the fields are located towards the bottom of
the label.

Click on the side scroll bar until you see the fields.

“Microsoft FoxPro
File Edit View Data Tools Object Report Window Help

: : |Address.
...... e e ALLTIC Ry M ALLT(State )y " ALLT(ZiD) |

Move the fields to the tdp left of the ]abel, as shown below.
Make sure that you move the first field to the 0,0 position.

: Microsoft FoxPro
=| File Edit VYiew Data Tools Object Report Window Help

Object Top: 052 Left 000 Bottom: (.68  Right 228 Height 017 Width: 2.29 [ine [Hum
Select Save from the File Menu.

Select Close from the File Menu.

continued on next page
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Select Print from the Catalog Manager.
The Catalog Manager Print window will be displayed.
Select Printer as the destination.

Click on OK.
= Microgoft FoxPro.
File Edit View Data Tools Window Help
FoPro Catalog Manager Thee Thum T
The Print window will be displayed.
Click on Setup.
Printer: Default Printer (HP LaserJet Serie
 NentPriy :
Print Range

bow [ 1

Print Quality: [300 dpi B]
[ Print to File

Copies: E::I

[ collate Copies

Select the Generic/Text Only printer driver.
Click on OK

Printer: Generic / Text Only on LPTT:

Print Range
® Al

O Lekotion
O Pages

fom [ 10

Print Quality: ingh ’il
] Print to File

Copies:

Cullate Coples

Set the ADDRESS SETUP, located in the Bryce printers Setup Menu, to 66 lines.

You are now ready to print.
Click on OK.
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Appendix F ¢ Printing with Software

Software interface sample: LOTUS 123 Release 3.1+ for DOS

Before running 123, the Bryce printer must be installed by choosing "GENERIC" 'no
backspace' for printer specification.

Run 123

~ Address should be entered in a single column, all addresses in file must have the same number of
lines (add blank lines if required).

Set the ADDRESS SETUP in the BOS OEM menu to equal the number of lines each record. If
page breaks are used, set ADDRESS SETUP in the BOS OEM menu to 1 line more than the
number of lines in each record.

Turn AUTO LINE FEED ON in the OEM Setup Menu.

Select PRINT

Select PRINTER
Select OPTIONS
Select OTHER
Select UNFORMATTED
Select ADVANCED
Select AUTOLF
Select YES

Select QUIT

Select QUIT

Select GO
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Software interface sample: MailMiser ver 1.2

Refer to the MailMiser User's Guide to setup a database for printing labels.
While using MailMiser, a label must be defined in order to print your addresses on the BOS
OEM.

Select System/Printer Functions (9) from the Main Menu.
~ The System/Printer Function Menu will be displayed.
Select Printer Selection (3).
The Print Selection Menu will be displayed.
Select BRYCE BOS 12K.
You will be returned to the System/Printer Functions Menu.
Enter data according to the following table.

1. Function "Typing" Keys

2. Rebuild Indexes

3. Printer Selection Bryce BOS 12K
4. Reset Printer Yes

5. Special Printer Codes

6. Default Directory

7. - Color/Monochrome enter monitor type
8. Delivery Point Barcode NO

9. Printer passes for Barcode 1

0.  Exit to Main Menu

Select Exit to Main Menu (0), after you have entered the above data.
The MailMiser Main Menu will be displayed.
Select Label/Envelope Sizes (8).
Select Choose from standard label sizes (1).
Select Direct Image Printer, 1 up, 0 margin.

MailMiser will ask you if you want to Print a Test Pattern, select NO at this time, this will return
you back to the Main Menu.
Select Label/Envelope Sizes (8).
Select Edit current label size (2).
Enter data according to the following table.

Label Description Direct Image Printer, 1 up, 0 margin
Label Width 4.5

Left Margin 0

Inches from top of 1 label to top 1.167 (for a 7 line address)

of next label approx. .167 per line, at 6 Ipi
Number of Labels across 1

Number of Spaces Between Labels 0

Lines Per Inch 6 Ipi (default)

Characters Per Inch 10 cpi (default)

Select Print Labels from the Main Menu to print addresses.
NOTE: Select NO when the program asks you if you want to print Postnet Barcode.
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Software interface sample: MULTIMATE

An address may be printed using Multimate Merge Print.

Refer to MULTIMATE and create a merge file. The following is an example of a typical merge
document for addressing:

name
title

company

address

city state zip

From the main menu, select merge print, When the DOCUMENT PRINT OPTION screen is
reached, set up the following section of parameters as shown below:

Enhanced [N]/ Draft [Y] Y

Print Action Table (PAT) TTYCRLF
Pauses Between Pages [N or Y]
Print Comments [N or Y]

Print Document Summary [N or Y]
Print This Screen [N or Y]
Justification [N or Y or (M)icro]
Lines Per Inch [6 or 8]

Paper Length (lines per page)

*NZZ2Z22ZZ

The option listed on the document Print Option screen which are not listed above are either not
applicable to printing addresses or are specific to your particular installation.
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Software interface sample: MyMailList ver. 1.9.7

Addresses may be printed on the BOS OEM using MyMailList.

After entering your data:
Press F3, the cursor will move into the Print Format window.
- Select 3 1/2 x 15/16 labels S
1 label across
0 left margin

1 copy

NOTE: MyMailList does not allow you to create a custom label size, therefore you
have two choices;
1. 3 1/2 x 15/16 labels - this limits you to 6 lines per address and
35 characters per line.
2, Envelope - this also limits you to 6 lines per address, and
pauses the printer after each address.

Press F4, the cursor will move into the Print window.
Enter the Start and Stop Data as required.

Set ADDRESS SETUP on the BOS OEM to 6 lines.

Press F10 to Print.

MyMailList is set to print to whatever printer you have connected to Parallel Port #1 (LPT1). If
your BOS OEM is not connected to LPT1, press Ctrl-P to view the Printer Choice Menu., and
select the correct port.
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Software Interface sample:  Postalsoft Desktop Mailer ver. 5.0 for Windows
Installation:

Follow the instructions in the User Manual to install Postalsoft Desktop Mailer. Install the Bryce
10K printer driver that is supplied with Postalsoft Desktop Mailer.

Select New from the File Menu.
~Select the required fields. (See the new record layout example below.)

Hecord Layout

Predefined fields: [

L«

Fields in record:

rField Pl’upx;ﬁ;‘.a

LAST
Nome: [FIRST I New ||| ada» ]gggggggl

ADDRESS 2
Kind: [Firstname Bl Insert >> ] priyii
Ccchemave | 20
<
Type: @ Character O Humber O Fioat W 2P

DP2
O togicat  Obaie O sems Change >> | |CRRT
LOT
Size: [12 Secimad places: ‘éé LOT_ORD

! Copy other window's layout l

Attrib: [T indexed [ Caded [T Hidden

X Index deletions [~ Advanced options ! OK _I I Cancel l I Help I

When the data is inserted into your database, you must select a template.
Select Choose Template from the Print Menu.

Select New.

In the example below, a template named bryce.tpl has been created.

~Edit Template

Template: Field names: Commands:
{Bar} + IFIRST Pkg. mark Both
[FIRST] [LAST] LAST Pkg. mark Endorse
[ADDRESS 1] ADDRESS_1 Pkg. mark First
Cl STATE] 21 CITY Pkg. mark Sticker
(e 1P STATE Record number
ZIP Sequence
DP2 Underline = off
DPC Underline = on
ERR_STAT Units = cm.
Units = in.
Name: | inse field I ] tnneet command l
bryce.tpl
l l New line l | Save I l Cancel '
Description:

‘bryce template

continued on next page
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When the template is created, you must choose a form.

Select Choose Form from the Print Menu.

Select New from the Choose Form for Printing Menu.

Enter the parameters into the Edit Form window as shown below.

F_- Labels across page r1— Labels down page

4.2 Width of label [12 " Heightof 1abel
F]TD——- Left margin (to paper edge) [0.000 Top margin

0.000 Width between labels W— Height between labels

|4.2 Form width |1.2 Form height

Form name: Units—————— rForm Kind Origntation
IBryce.frm @® Inches @ Continuous | | @ Portrait
Description: O Centimeters| | O Sheet O Landscape

[Label for Bryce 10K, 10K-E, 12K, 16K & 20K

Save Cancel } |Options... Help

The next step is to select a printer.

Select Choose Printer from the Print Menu.

Select Bryce 10K on LPT1 (LPT1 is used as an example, the actual printer port that you have
the Bryce 10K assigned to in Windows will be displayed here.)

Click on OK

Set the ADDRESS SETUP, located in the Bryce printers Setup Menu, to 8 lines.

You are now ready to print.
Select Print Labels from the Print Menu.
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Software Interface sample:  PreSort Pro by MCS version 2.4 for Windows

Installation:

Follow the instructions in the User Manual to install PreSort Pro. Install the Standard/Text only
printer driver that is supplied with PreSort Pro.

—-Select New from the File Menu.

Select the required fields. (See the new record layout example below.)

Predefined fields: | K|

Fields in record:

~ Field Properties T

LAST

Name: [FIRST ||_New ] |[_add>> | |company
ADDRESS_1
ADDRESS_2

Kind: lFilst name I;!_l @ CITY

2o
Ivpe: @ Character ) Mumber ()} Float i g'F?Z
O vegeat - O pate O Mems

Size: Dechnal placey

Attiib: [ Indexed [ Coded [ Hidden

l Copy other window's layout l
22

[ Index deletions ] Advanced opti [ ok ]| cancel ]| Hep |

When the data is inserted into your database, you must select a template.

Select Choose Template from the Print Menu.

In the example below, a template named bos_test.tpl has been created. Notice that there are no
printer control codes displayed at the beginning or end of the template.

Template name: View of template:
adrl.tpl | | [FIRST]LAST]
adr2.tpl [COMPANY]

adr3.tpl [ADDRESS_1]
barl.tpl [ADDRESS_2]
bar2.tpl [CITYLISTATE]. [2IP]
barenv3.ipl

bulkbare.tpl
bulkbars.tpl

Description:

I Select ” Cancel ” Edit... ” New... ”Rename...”chetc...” Help l

continued on next page
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When the template is created, you must choose a form.
Select Choose Form from the Print Menu.
Select bryce.frm from the Choose Form for Printing Menu (shown below).

Choose Form for Printing

Form name: ‘ View of form: ;

bagtag1.frm (. /o 1 2 3 4 5 B8

hataz-ffm n. ' folot I l.l.l.l 1ol I 1 |.l.‘.l.l.l I i |.|.| "'Zonm

bryce.frm 0 —

cheshire.frm E j z {,:; Closeup

dotladrl.frm 131, . > Med.-close
dotladr2.frm 3 ® Normal
dotladr3.frm 2 = O Med.far

dot1crd1.frm E ) Far
dotldsk3.frm 3 -

dotldsk5.frm - ~ Units
dot1fil1.frm 4 @ in. [frac.)
dotlnam1.frm E Oin (dec)
dotlroll.frm 5 —

dotlrol2.frm = O cm.
“|dotlshpl.frm [

Description:

‘ Select l Cancel ’ Edit... New... ]Bcname...” Delete... Help

The next step is to select a printer.

Select Choose Printer from the Print Menu.
Select Standard/Text Only, (as shown below).
Click on OK

Choose Printer Setup

Printer

Epson LQ-850 on COM1: | Ok l

Generic } Text Only on LPT1:
HP DeskJet 500C Printer on LPT1: Cancel
HP Desklet Printers on LPT1:
HP LaserJet Series ll on LPT1:
Pitney Bowes W700 on LPT1:
Standard / Text Only on LPT1:

Setup...

Help

Set the ADDRESS SETUP, located in the Bryce printers Setup Menu, to 8 lines.

You are now ready to print.
Select Print Labels from the Print Menu.
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Software interface sample: RAPIDFILE

Before running RAPID FILE, a printer driver must be loaded. This is done by running RAPID
FILE's Printer program from DOS as explained in the RAPID FILE manual.

The printer file to select is called GENERIC and must be set up as one of the prmter dev1ces
~——with appropriate 1/0 port settings.

From within RAPID FILE when printing addresses:

Select FILE from the main menu

Select RETRIEVE FILE or CREATE ( If you choose to create, enter data)
Select LAYOUT

Select LAYOUT TYPE

Select LABEL

When asked if you want to design a label - Select YES

AR AN

A LABEL WILL BE DISPLAYED IN THE CENTER OF THE SCREEN

7. Press F10
Select SHOW FIELD, Fields will be displayed on the right side of the screen.
Select FIELD
Use arrows to set field width.
Use arrows to drag field into position.
REPEAT Step 7 until all fields are placed
8. Press F9 to Implement
9. Select PRINT from main menu
10.  Select DESTINATION
11.  Select BEGIN PRINTING
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Software interface sample: REFLEX ver. 2.0

Referring to the REFLEX manual, run REFLEX, load a file, or create a file.
Create the fields required.

~Select Reports & Labels from the Views Menu.
This will bring you to the Report Design display.

Select Make Labels from the Report Menu.

Select Customize Labels from the Report Menu.

Set:  Label Width: 45

Label Height: 7

Lines between labels: 0

Spaces between labels: 0

Labels across page: 1
Compress blank lines: Yes or No
Left margin: 0

Setup String: (blank)

Select Proceed.
Place cursor at the beginning of the first line of the label.

Enter field names into label.

Select Local Properties from the Report Menu when you are done entering the field names into
the label.

Set the field widths as required, set State field width to two (2) characters.

Click on State and Zip fields, and move to create a space between the City and State field, and
the State and Zip field.

You are now ready to print addresses on your BOS OEM.
Select Print from the Utilities Menu.

Set Address Setup on the BOS OEM to seven (7) lines.
Select Print to Printer.

Select Proceed.
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Software interface sample:  WORDPERFECT 6.0

Addresses may be printed with WORDPERFECT 6.0 using merge printing. This requires the
creation of a primary and a secondary file. Refer to your WORDPERFECT manual for
instructions.

~~The following is an example of a typical merge primary file for addressing:

{FIELD}1"
{FIELD}2"
{FIELD)3"
(FIELD}4"
{FIELD)}5"

The following is an example of a typical secondary file for addressing:

John Doe{END FIELD}
123 Main Street{ END FIELD}
Anytown, CT. 12345-6789{ END RECORD}

Before performing the actual merging of data from your secondary file, several options must be
chosen:

Set Margins Top 0"
Bottom 0"
Left 0"
Right 0"

You may now merge the two files.

From the Tools menu, select Merge
Select Run
Enter Form filename (Primary File)
Enter Data filename (Secondary File)
Select Merge

From the File menu, select Print/Fax
Select DOS Text Printer
Select Edit, and insure correct port is selected for the DOS Text Printer

You may now print address lists on your BOS OEM Print Station.
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_Appendix F o Printing with Software

Software interface sample:

WORDSTAR FOR DOS ver. 7.0

From the File Menu select New.

From the Layout Menu select Page.

-~ Enter the following settings:

0.00
0.00
0.00
0.00
0.00
0.00

Portrait

1.34

Leave Blank

The screen should now display the following information:

0Odd Offset
Even Offset
Top
Bottom
Header
Footer
Orientation
Page Length
Paper Bin

Select OK.

.poo .00"

.poe .00"

.mt  .00"

.mb  .00"

Jhm 00"

fm 00"

.pl .00"

.pl 1.17"

Enter in the data for each record. When a record is complete, press ENTER until a page break is

displayed on the screen (a solid horizontal white line).

Once the page break is displayed, you can enter the next record.

Repeat this process to enter all records.

To Print:

Set the BOS OEM Address Setup to eight (8) lines of address.

Select Change Printer from the File Menu.

Select Draft Printer.

Select OK.
Select Print from the File Menu.
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___Appendix F ¢ Printing with Software

POWER PRINT for the MACINTOSH

PowerPrint by GDT Softworks consists of software printer drivers and a high speed serial-to-
parallel adapter which allows for a virtually transparent connection between your Macintosh and

the BOS OEM.

__Installation:

Follow the instructions in the User Manual to install PowerPrint. Select the LaserJet 4 printer

driver to install for use with the BOS OEM.
Activating Your Driver:
¢ Go to the Apple menu and select Chooser.

o Select the LaserJet 4 printer driver.

» Click on the serial port to which you have the BOS OEM connected, either the modem

(phone) or printer icon.

NOTE: If you are connecting your printer cable to the printer port, Appletalk must be set to

"inactive”.

e Click on the box labeled Cartridges. A Cartridge Mapping window will be displayed. Map

the following fonts:
Mac Font called Courier to print as the HP Font Courier.
Mac Font called Helvetica to print as the HP Font Arial.
Mac Font called Times to print as the HP Font Times New.

e (lick on OK.

o Close the Chooser by clicking on the close box in the upper left corner. The Address Printer

is now configured to print with the PowerPrint driver.
Printing:
Go to the Setup Menu on the BOS OEM and turn on Auto Line Feed.

While in an application, go to the File menu and select Page Setup. Select:
o Paper = US Letter

e Reduce or Enlarge = 100%

o Page Orientation = Portrait

s Printer Effects = Fractional Widths

Click on OK
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Appendix F ¢ Printing with Software

POWER PRINT for the MACINTOSH (Continued)

Page Setup:

e Select Show from the Layout menu, then select Non-Printable Area.
e Set page width to 8.5 Inches (215.9 mm).

e Set page length to 11 inches (279.4 mm). ~ =
Measure the position of your address from the bottom edge of the paper, Just as you would from
the bottom edge of your mail piece. See example shown below.

8.5 x 11 Inches

Non-Printable

E e area

Printable

/ area

Bryce Office Systems ;7:4 —
115 Hurley Road i F
Oxford, CT 06478-1035
2.0 Inches
. 2
le N
4.0 Inches 'l
Go to File menu and select Print. Select:
e Print Mode = Draft
e Feed = Automatic
Click on Print.
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Computer setup sample: IBM Mini's (System 34, 36, 38) & AS400

To use the BOS OEM with any IBM minicomputer or mainframe, it is necessary to interface
through some kind of protocol converter. This may be one of two types of systems; either an
IBM compatible micro with an emulation card, or a stand alone protocol converter such as is
available from Black Box Corp. in Pittsburgh, PA (1 e., model PQ 6 RO) In either case the

—installation is very similar. : -

1. The protocol conversion device must be connected to the IBM computer with the
appropriate  cable.

2. After deciding on a free work station address to be used for the BOS OEM, the system
configuration must be altered to setup the work station address and port as an IBM 5256
printer.

3. The emulation system must be setup at the same workstation address and must be setup

for  IBM Proprinter II emulation.

For a system 36 installation, with IBM advanced emulation, the following is the correct
procedure to follow on the PC:

Boot the PC with DOS

Running off the advanced emulation program disk, type "Config DP5250.dat"
Select 2 Emulation sessions

Select the appropriate keyboard

Set workstation addresses for the two sessions, as configured on the system 36
Set 5256 Printer Emulation

Select IBM Proprinter I1

Save profile data and exit

TommoNw >

4. A procedure must be written and run which sets the printer port for the page length of 6
lines (BOS OEM with LCD SETUP MENU to set up the ADDRESS SETUPto  6).

5. An RPG program will probably be necessary on the system 36 to produce a data format
which is "one-up" label compatible.

6. You may now print address lists on your BOS OEM.
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Software interface sample: MICROSOFT WORD FOR WINDOWS ver. 2.0

Using you mouse Select FILE
Inside the pull down menu for File, Select NEW
Once New has been selected a pop up window will appear.
Scroll through the available documents using the down arrow, Select MAILLABL
Now a new pop up window appears called Mailing Labels
Inside the Mailing Labels section, Select DOT MATRIX
Now another new pop up window appears called Dot Matrix Printer Label Sizes.
Scroll through the selection of product numbers for Avery Dot Matrix Labels,
Select 4600 ADDRESS
Then Select OK
Now another new pop up window appears called MicroSoft Word.
Select SINGLE LABEL
Now a new pop up window appears called Mailing Labels which depicts a sample
label for six (6) lines.
Type data into each line of the label address, TAB to go to NEXT LINE
When address data is completely entered, Select DONE
To print the sample label, select FILE
Inside the pull down menu for File, Select PRINT SETUP
Now a new pop up window appears called Print Setup
Select GENERIC/TEXT ONLY ON LPTI
Select OK
Select FILE
Inside the pull down menu for File, Select PRINT
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Software interface sample:  Word97 for Windows 95

Select Page Setup from the FILE menu.
Select the Margins tab, and set ALL margins to zero (0)

Select the Paper size tab, then select Custom from the Paper size text box.

Set the page width to 4.2”
Set the page heightto 1.4”
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Appendix F ¢ Printing with Software

Select OK. After you select OK, you may see a warning similar to the warning shown
below. Click on the Ignore button. — .

Select Page Layout from the
VIEW menu, and your page
should look similar to the example
show below.

_To print to the OEM printer:
Note: Make sure that
the ADDRESS SETUP
option in the Bryce
Setup Menu is set to
Nine (9) lines or
greater.

Select Options from the TOOLS
menu.

Select the Compatibility Tab
from the OPTION dialog box.
Select Custom from the
RECOMMENDED OPTIONS
FOR: pull down menu. Check
the box next to the Use Printer
Metrics to layout document.
Verify that none of the other
boxes have a check inside. The
dialog box should look like the
options box below.

M
;
7

- Substitute fonks based or font size
™ Suppress extrs line spacing at bottom of page
1™ Suppress extra line spacing st top of page
™" Suppress extra line spacing at top of page ke Word 5.x for the Mar
™ Suppress extra line spacing like WordPerfect 5.x
T Suppress Space Before after a hard page or column break
I Swap left and right borders on odd facing pages
™ Treat \" as " in mall merge data sources
[ Truncate Font height

i ger small fike: Waord 5. For the Macintosh
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To make a Mail Merge select Mail Merge from the TOOLS menu.
The Mail Merge Helper window similar to the one - ,
to the right will appear. Select the Create pull Mail Merge Helper
down menu.

Select “Form Letter”. Select the “Active
Window”” as the document that you wish to use.
Select “Get Data’ from the Mail Merge Helper.
Select the file you wish to merge with your MS
_Word document. You will get a message similar to
the one below stating “Word found no merge
fields in your main document”. Click on the
“Edit Main Document” button.

Move the cursor to the position you would like
your address to begin.

Select “Insert Merge Field” from the toolbar.
Insert the fields you want on the form.

Select the Merge to Printer icon from the toolbar.
Your page should look similar tot he last example
below.

The Print dialog box will appear.

~Make sure that the Generic/Text only printer is
selected. e
Click OK to print.  Microsoft Word

W Microsoft Word - Document2

N ¢First Name »-«Last Maroe »|
. «Street»]
<City»

ot

g
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Appendix Ge Technical Specifications

Shipping Dimensions and Weight

Height: 16.0 inches  40.64 cm
Width.: 26.0inches  66.04 cm
Depth: 11.0inches  27.94 cm
Weight: 31.4 Ibs. (14.2 kg) including accessories.

~———-Dimensions of Control Box R o - - w&%‘é{

Height: 8.5 inches 21.59 cm v
Width.: 7.0 inches 17.78 cm %J\gw\
Depth: 3.6 inches 9.14 cm rgﬂf
Electrical
Voltage: Selectable voltages: 100v, 120v, 220v, and 240v
Fuse Type (100 — 120 volts AC + or - 10%): One 3 AG 2 Amp Slo-Blo fuse, at 250 volts,
: is required/provided.
Frequency: 50/ 60 Hertz. + or - 3 Hz.
Fuse Type (220 — 240 volts AC + or - 10%): Two 5 x 20mm. 1.5 Amp Slo-Blo fuses, at
L 250 volts, one for each leg, is
required/provided.

Environmental Conditions.

Operating. (Power On.), Temperature. 55.F - 95.F (12.C - 35.C),

Humidity. 8% - 80%

Die maximale Umgebungstemperatur betraegt 35C.
Non Operating. (Power Off.), Temperature. 42.F - 100.F (5.C - 40.C),

Humidity. 10% - 90%

Effective Print Area
Maximum Height of print area — 6 inches (15.24 cm), can be split into 4 — 1% inch (3.81 cm)
blocks
Maximum length of print line — 13 %2 inches (34.29 cm)

Print Density and Resolution. Black
Super Draft 600 x 150 Dots per inch
Draft:- 600 x 200 Dots per inch
Letter:- 600 x 300 Dots per inch
Executive:- 600 x 600 Dots per inch
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Speeds for Printing
Print Quality | Belt Speed in ips = inches / second | Max
Throughput / Hr
Super Draft Up to 96 ips (243 centimeter/sec) 40,000
Draft:- Up to 72 ips (182 centimeter/sec) 30,000
~Letter:- Up to 48 ips (121 centimeter/sec) | 20,000
Executive:- Up to 24 ips (60 centimeter/sec) 10,000
Fonts

5 Internal Fonts that are scalable

Point Size

Smallest
4 point

" The Interface Panel

Largest
30 point

Unlimited TrueType Fonts

The interface panel is located on the side of the machine. It contains the main power switch, the power
receptacle and fuse. The interface ports (parallel and serial) are the interface connections between the

OEM and your computer.

1. Connect the line cord from the printer receptacle to a properly grounded outlet box. Do not use
an adapter plug. Avoid using outlets that are controlled by wall switches and shared with other
equipment.

2. Connect the interface cable from the computer to the appropriate connector on the printer

interface panel. The typical cable length is six (6) feet long (182. 9 cm) for parallel and fifteen
(15) feet (457.2 cm) long for serial.
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_Appendix H ¢ US Mail Requirements

DELIVERY POINT BAR CODE

- NAIC Certification

This Address Printer is equipped with firmware for printing the United States Postal Service (USPS)
Delivery Point Bar Code (DPBC). The printer is Certified by the National Address Information Center
(NAIQ). Certification from the NAIC indicates the printed POSTNET Bar - Code meets the required
standards for letter size mail to receive USPS Delivery Point Bar Coded rates.

Delivery Point Bar Code o : '
A Delivery Point Bar Code is comprised of a total of 62 bars: Frannng Bar + ZIP + 4 nglts + Dehvery
Point Digits (2 digits) + Check Digit + Framing Bar. The Address Printer uses the data sent down on the
last line to print the DPBC.

Alternate Address Formats
The option to send the Address Printer a ZIP + 4 + 2 or ZIP + 4 + 3 address to print a Delivery Point Bar
Code is available. Only the addresses with ZIP + 4 (9 digits) or ZIP + 4 + 3 (12 digits) digits are allowed
by the USPS to appear in the address block.

Customizing the location of the Barcode
Use the following 11 or 12 digit formats to print the barcode in any desired location on the media:
~~ZIP +4 + 2 (e.g. ~~98765-123412) or ~~ZIP + 4 + 3 (e.g. ~~98765-1234123)
Note: The only characters that can precede the “~~" tilde tilde characters are blank spaces.

Example of using the

Tilde Tilde (..,,.) ekl kofotok ol kool ok § DIGIT
command for #JANO93 000 MD #123BL
customizing the bar

code location in tbe XYZ Corporation

address block while 123 Washington Road

placing a USPS Anytown, CT 06470-1234

barcode below the

address. "Illlllllll Illlll Illllll' II"IIII“

The Tilde Tilde (~~) code

barcode will print on a line ASCII text sent to produce the above example is:
when the first two characters ~~123456789012 (Tilde Tilde Code & Barcode data sent)
in the Iine are two ﬁlde tilde sk sfe sl sfe sfe sfe st e sfe sk sk sk e sfe sfe sk *#‘**%‘*ﬂ’ﬂ‘s DIGrT
characters (~~) followed by #JAN93 000 MD #123BL
the digits that represent the
desired barcode. XYZ Corporation
123 Washington Road

Anytown, CT 06470-1234~123 (USPS information sent)
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Valid Address Formats

ZIP + 4 + 2% 98765-1234~12 98765-1234 DPBC
ZIP + 4 + 3* 98765-1234~123 98765-1234 DPBC
ZIP+4+3 98765-1234123 98765-1234123 DPBC
Illegal Format
ZIP+4 | 98765-1234 | 98765-1234 | 9Digit Bar- Code
ZIP+4+2 98765-123412 98765-123412 No Bar - Code
* Add the Tilde (~) after the ZIP + 4 digits so the 2- or 3 - digit add on will not be printed in the
address block.
ZIP + 4 +2

The Address Printer will determine the correction digit and print the DPBC according to the ZIP code
received. Using the ZIP + 4 + 2 format requires that the Tilde (~) character be sent between the ZIP + 4

and 2- digit characters. Only ZIP + 4 digits will be printed in the address block.

ZIP +4 + 3

~ The Address Printer will print the DPBC according to the ZIP code received. Two formats of printing the
Zip Code in the address block are available. First option is to print all the digits of the ZIP + 4 + 3 in the

address block. Second option is to only print the ZIP + 4 digits in the address block, by placing the Tilde

(~) character between the ZIP + 4 and 3- digit characters.
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PLANET Code Bar Code

Postal Alpha-Numeric Encoding Technique (PLANET) provides features that are not currently
available with the POSTNET barcode. PLANET bar codes are broken down to a list of planets.

The following is a list of each planet and the applications supported by that planet’s particular
PLANET bar code.

0

O o oo o o

~Jupiter- A 12-digit barcode containing mail piece rate, presort bureau origin, and customer

identification.

Mercury - A 12-digit barcode used for CONFIRM or CIPS service.
Earth- A 12 digit barcode used for sorting foreign mail.

Pluto- A 12 digit barcode for automated address correction requests.
Saturn- A 12 or 14 digit barcode for RTS or CFS mail.

Neptune - A 12 digit barcode for mailer use.

Venus - A 12 or 14 digit barcode used for electronic tracking.

The PLANET bar codes have the exact same dimensional requirements as POSTNET barcodes.
Most PLANET barcodes are placed in the address block portion of the mail piece. Only
PLANET Earth and Saturn barcodes may be printed in the traditional lower right area.

Example of using a

PLANET bar code in sk okl ok sk skt sk ok §. DIGTT
the address block while #JANO3 000 MD #123BL
p]aC]ng aUSPS | s ' ] Il Ill Illl L | l | ll' lI"llllI Illll'
barcode below the .
address. XYZ Corgoratxon
123 Washington Road

Anytown, CT 06470-1234

A PLANET code barcode will print on a ASCII text sent to produce the above example is:

line when the first two characters in the

******#5*****************5 DIGIT

line are a tilde followed by the pound #JAN93 000 MD #123BL
character (~#) then the digits that ~#123456789012 (PLANET Code sent)
represent the desired PLANET code. XYZ Corporation

123 Washington Road

Anytown, CT 06470-1234~123 (USPS information sent)
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Appendix | « EAN / UCC Requirements

EAN-13/ UPC-A Serial Shipping Barcode

The printer has the ability to print a nominal sized EAN-13 and UPC shipping barcode in both
the normal or invert mode. The barcode consists of the machine readable barcode on top and the
human readable test beneath. The barcode is printed below and to the right of the current
position.

The barcode is dés',ighe'd to cdmply with the standard UCC/EAN Appiication Ideritifier stéhdard
and utilizes the UCC/EAN-128 symbolism.

To generate a UPC or EAN-13 barcode the digits to be coded must begin with a ~ (tilde) [Hex
7E] then an & (ampersand) [Hex 26] followed with the 12 digits for EAN-13. The printer will
automatically calculate the check-digit. Send ten digits and two leading 0’s (zeros) are added to
generate the EAN-13 barcode.

For the printer to generate a UPC or EAN barcode the data sent must follow the ensuing rules:
O A (~&) must be the first two characters.

O The EAN-13 must have 12 digits, the UPC must have 10 digits.
O Spaces are not allowed within the EAN / UPC information.
00 The EAN barcode information must be terminated with end of line characters (CR [Hex 0D]
) or LF [Hex 0A]).
0O Only use ACII text or use Courier 12 pt when using widows to send the EAN / UPC barcode
command and information. Note: If an illegal format is rec
Example: To print a EAN-13  ~&123987654321 the command will be ignored
To print a UPC ~&0198765432 only the text will print.
Prefix (P1, P2, P3) Code Number / Manufacturers Number / Item # | Check-digit
(X)

EAN-13 |PI |P2 |P3 | X [|[X |X |X |X
X X [X

X | Check-digit
UPC-E Pl | X [X X

Check-digit

it
ke

>

The dimensions of the EAN-13 at nominal size are:
O 37.29 mm wide including clear space for margins
O 25.93 mm height - measured down from the top of the line from which it was generated.

The dimension of the UPC-E barcode at nominal size are:

0 22.11 mm wide including clear space for margins

0O 25.93 mm height — measured down from the top of the line from which it was generated.
Keep these dimensions in mind when laying out the design for using the EAN-13 Barcode and
the UPC-E barcode.
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Appendix J ¢ Glossary

Glossary

cable
Wires that carry the information between the computer and the printer.
~ Centronic parallel interface
A device for connecting printers and other peripheral devices to a computer. It transmits a full
byte at a time.
Character
A printable letter or symbol.

character height

The height of a uppercase letter. A character height is measured in points.

- characters per inch

The number of character printed in a horizontal inch. Also called pitch.

character set

The set of characters or symbols that make up a language.

clean print cartridge

Describes the process of removing dried ink from the nozzles of the ink jet cartridge.

configuration
The settings used by the printer to communicate with the computer. Also the internal settings
in the printer that control the print job.

control code

The instructions sent to the printer to describe how to perform the print job.

control panel

The buttons and display that are used to manually change the printers settings.
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cpi
See characters per inch.
data communications

The sending of data from the computer to a peripheral device i.e. the printer.

__dots per inch
The number of ink dots printed in one horizontal inch. The larger the number the better the
resolution of print.

double feeding

Two or more pieces of media feed at the same time or without separation.

Dpi

See dots per inch.

~draft quality

Print resolution using 150 dpi which saves ink and allows faster printing of a document.

Drivers
A file used by the computers software to communicate commands and information that the
printer needs to layout and print a document.

embedded printer commands

Commands sent in a record or document to instruct the printer to change printing options.

EPROM
Electronic Programmable Read Only Memory

escape character
A special non-printable character (ESC / =») used to instruct the printer to change printing
options.

escape sequence
Commands sent beginning with the escape character that instruct the printer to change
printing options: fonts, page orientation, etc.

feed gap

Opening between the ends of the H-Block Assemby and the Feed Rollers so the media is fed
one at a time.
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font

A set of printable characters with consistent style and characteristics.

Grounded

A electrical circuit that has a voltage of zero.

~Handshaking

A method for the computer to communicate with peripheral devices to ensure complete
transfer of information.

hex dump

A printer option that allows all the information and commands sent to the printer are printed
as base 16 digits.

Internal test address message

The preprogrammed Address that is printed when the Test Env. button is pressed.
interface cable

The cable that connects the printer or other device to the computer.
interface connector

The connectors on both ends of the interface cable that insert into the interface ports.
internal fonts

Resident or built-in fonts that reside inside the printer.
Jam

See Paper Jam.
letter quality

Print resolution using 200 dpi which saves ink and provides a high quality document.
lines per inch

The number of lines printed in one vertical inch.

Menu directories

The list of available printer controls that appear on the bottom of the LCD display. A
directory can contain other directories called sub-directories.

Offline

The printer will no longer respond to information sent from the computer.
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Online

The printer will accept and respond to information sent from the computer.

outline fonts

Scaleable printer fonts.
_paperjam o
When media gets stuck in the printer.

Parity

An error checking method used when communicating between the computer and a peripheral
device.

PCL commands

A standard printer language developed of commands to access printer features or options.

point size

A measurement standard for Character Height. One point represents one seventy-seconds of
an inch.

Port

See Printer Interface Port.

Postal regulations
Rules and guidelines setup by the United States Postal Service (USPS) for mail.

power socket

The socket on the back of the printer where the line cord is connected.
print cartridge

The cartridge that contains the ink for printing.
print quality

The quality of print, such as the resolution, sharpness of the image or font.

printer driver

See Drivers.

Record

A collection of related fields that make up the name and address of an individual in a
mailing-list file.
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sans serif

A font typeface that contains no serifs or finishing strokes on the top or bottom of the
characters.

scaleable fonts

Outline printer fonts of characters and symbols that are stored in a mathematical form and are
able to be enlarged or reduced.

Spacing

The relative spacing between characters.

Stuffed media

Media that is already filled and sealed for delivery.

sub - directories

A directory within a directory.

Troubleshooting

The process of finding the cause of a problem so that a solution can be found.
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Appendix K ¢ Ordering Information

\Z

Options & Supplies

The following list of option & supplies are available through your local Bryce dealer .

External Fonts & Supplies

QDfem borio

Description Part Number %Wg}&?
Font Card:
Alpine 56-96000-001 W
~Awrora - --56-96001-001 . e :
Calico 56-96003-001
Centurion 56-96022-001
Dingbat #2 56-96005-001
Eureka 56-96006-001
Indio 56-96008-001
Memo 56-96010-001
M % Mettler 56-96011-001
Ve /()D Oakland 56-96012-001
R OCR A 56-96013-001
o©° Palomar 56-96014-001
- Parker 56-96021-001
Santee 56-96016-001
Stockton 56-96019-001
3 of 9 Barcode 56-96020-001
Novarese 56-96031-001

Alternative Kits

Description Part Number
Kit: ~

Encoder Assembly 01-10003-201

Reflective Sensor Assembly 32-50013-002

Q.D. Retro-Flective Sensor Assembly 32-50013-20 , r»é)ﬁﬁﬂ v\

Retroreflective Tape (2” or 5 cm) 50-80015-01 % ’ Z’O

Cartridge Capping Station 03-40000-201 g{;ﬂ
Memory: . c

32 Meg DIMM 50-51105-001 £ " P L

i £

Print Head Assemblies: ch' ©

One Head 01-10002-201 g

Two Heads 01-10002-202 ,;0/

Three Heads 01-10002-203 @vvﬂi’ﬂ)

Single Six Heads 01-10002:206 =" 2!

)

Mounting Kits: - \DD

Right Hand Mounting Bracket Kit 05-10001-201 &

Left Hand Mounting Bracket Kit 05- IOOOO 201

Bundvet %ahbw fureen v
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